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	WEEK 3
	

	
	
	Realistic Fiction
	
	Realistic Fiction
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	How Many Stars 
in the Sky?
	
	Maybe Something Beautiful
	
	
from Places We Go
	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Foundational Skills
	Phonological Awareness: Long and Short Vowels
	
	Phonological Awareness: Long and Short Vowels
	
	Phonological Awareness: Rhyming Words
	

	
	
	Phonics: Long and Short Vowels
	RF.2.3.a
	Phonics: Long Vowels CVCe
	RF.2.3.a
	Phonics: Consonant Blends
	RF.2.3

	
	
	High-Frequency Words: which, each, than
	RF.2.3.f
	High-Frequency Words: called, long, most
	RF.2.3.f
	High-Frequency Words: more, things, sound
	RF.2.3.f

	
	Minilesson 
Bank
	Infographic: Seeing Stars
	RI.2.7; W.2.8
	Infographic: We Make Our Neighborhood Better
	RI.2.7
	Diagram: Fighting Fires
	RI.2.7

	
	
	Realistic Fiction: How Many Stars in the Sky?
	RL.2.10
	Realistic Fiction: Maybe Something Beautiful
	RL.2.1
	Informational Text: Places We Go
	RI.2.2

	
	
	Words That Tell About a Place
	L.2.4.d
	Words That Describe
	L.2.5.a; L.2.5.b
	Words That Tell About the Community
	L.2.4.e

	
	
	Describe and Understand Setting
	RL.2.7
	Describe and Understand Characters
	RL.2.7
	Identify Main Idea
	RI.2.2

	
	
	Use Text Evidence
	RL.2.7
	Ask and Answer Questions
	RL.2.1
	Use Text Evidence
	RI.2.6

	
	
	Talk About It: Oral Response to Realistic Literature
	SL.2.1.a; SL.2.1.b
	Write to Sources: Respond to Realistic Literature
	W.2.8
	Talk About It: Oral Response to Informational Text
	SL.2.1.a

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.2.4.c; L.2.4.e
	Synonyms
	L.2.5
	Context Clues
	RF.2.4.c

	
	
	Handwriting
	Use Proper Sitting Position and Paper Position Use Proper Pencil Grip
	L.1.1.a
	Write the Letters Ll, Ii, Tt, Oo, Cc, and Aa
	L.1.1.a
	Write the Letters Ee, Ff, Dd, Gg, Jj, and Qq
	L.1.1.a

	
	
	Read Like a Writer/Write for a Reader
	Voice
	L.2.4.a
	Sequence
	W.2.3
	Relevant Details
	RI.2.6

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Meet the Author
	SL.2.1
	The Writer’s Notebook
	SL.2.1.b
	The Structure of a Fiction Text
	RL.2.5

	
	
	Meet the Author
	SL.2.1.b
	The Writer’s Notebook
	SL.2.1
	The Structure of a Fiction Text
	RL.2.5

	
	
	What Good Writers Do
	SL.2.1.c
	Tools Authors Use
	L.2.2.e; L.2.5.b
	The Structure of a Nonfiction Text
	W.2.2

	
	
	What Good Writers Do
	SL.2.6
	Tools Authors Use
	L.2.2.e; L.2.5.b
	The Structure of a Nonfiction Text
	W.2.2

	
	
	Writing Club
	SL.2.1.a
	Digital Tools Authors Use
	W.2.6
	Digital Tools Authors Use
	W.2.6

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Words with Short Vowels
	L.2.2
	Spell Words with Long Vowels (CVCe)
	L.2.2.d
	Spell Words with Consonant Blends
	L.2.2.d

	
	
	Language & Conventions
	Simple Sentences
	L.2.1.f
	Subjects and Predicates
	L.2.1
	Compound Sentences
	L.2.1.f



 (
UNIT 1 
SKILLS OVERVIEW
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
Essential Question
)
How do different places affect us?
	WEEK 4
	
	WEEK 5
	

	Poetry
	
	Realistic Fiction
	

	
Poetry
	
	You Can’t Climb a Cactus
	

	
	CCSS
	
	CCSS

	Phonological Awareness: Rhyming Words
	
	Phonological Awareness: Add and Remove Sounds
	

	Phonics: Consonant Digraphs ch, sh, wh, th, ph; Trigraph tch
	RF.2.3
	Inflected Endings -s, -es, 
-ed, -ing
	RF.2.3

	High-Frequency Words: great, before, means
	RF.2.3.f; L.2.6
	High-Frequency Words: follow, form, show
	RF.2.3.f

	Poem: “City Sights”
	RF.2.3
	Infographic: Two Different Places
	RI.2.5

	Poetry: “Pete at the Zoo,” “Keziah,” “Rudolph Is Tired of the City,” “Lyle”
	RL.2.4; RL.2.10
	Realistic Fiction: You Can’t Climb a Cactus
	RL.2.7

	Words That Tell About a Feeling or Action
	L.2.5.b
	Words That Tell About a New Place
	L.2.4.e

	Explain Patterns and Structures
	RL.2.4; W.2.5
	Describe and Understand Plot Elements
	RL.2.7

	Monitor Comprehension
	RF.2.4.c; SL.2.1.c
	Make and Confirm Predictions
	RL.2.7

	Write to Sources: Respond to Poetry
	W.2.1
	Talk About It: Respond to Realistic Literature
	SL.2.1.a; SL.2.1.b

	Word Parts
	RF.2.3.d
	Oral Language
	L.2.5

	Write the Letters Uu, Ss, Bb, Pp, Rr, and Nn
	L.1.1.a
	Write the Letters Mm, Hh, Vv, Yy, Ww, and Xx
	L.1.1.a

	Word Choice
	L.2.5.a
	How Graphic Features Support Purpose
	RI.2.7

	Writer’s Craft
	Publish, Celebrate, and Assess

	End Punctuation and Apostrophes
	L.2.2; L.2.2.c
	Peer Edit
	W.2.5

	End Punctuation and Apostrophes
	L.2.2; L.2.2.c
	Incorporate Peer Feedback
	SL.2.1.c

	Revise Drafts by Adding Details
	L.2.1.e
	How to Write a Final Draft
	W.2.5

	Revise Drafts by Adding Details
	L.2.6
	Publish and Celebrate
	W.2.6

	Revise Drafts by Deleting Words
	W.2.5
	Assessment
	W.2.8

	Spell Words with ch, sh, wh, th, ph, tch
	RF.2.3
	Spell Words with -s, -es, 
-ed, -ing
	RF.2.3.f

	Sentences and End Punctuation
	L.2.2
	Use Resources to Spell Words
	L.2.2.e


	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_5.png]WEEK 6
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The Best Place
	

	
	CCSS

	FOUNDATIONAL SKILLS

	Phonics: r-Controlled Vowels ar, or, ore, oar
	RF.2.3.b

	High-Frequency Words: also, large, small
	RF.2.3.f

	Spelling: r-Controlled Vowels ar, or, ore, oar
	RF.2.3.b

	Compare Across Texts: “You Are Here”
	RI.2.9

	Inquire: The Best Place
	W.2.1

	Leveled Research Articles
	RF.2.4.a

	Academic Words
	L.2.6

	Explore and Plan: Introduce Persuasive Writing
	W.2.1

	Conduct Research: Interview an Expert
	W.2.8

	Collaborate and Discuss: Analyze Student Model
	W.2.1

	Primary and Secondary Sources
	W.2.8

	Extend Research: Include Media
	W.2.5

	Revise and Edit
	W.2.5

	Celebrate and Reflect
	SL.2.1




 (
RL.2.7, RI.2.5, RF.2.3.a,
RF.2.4.a, SL.2.2
)
	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING 	40–50 min.
READING BRIDGE 	5–10 min.
SMALL GROUP 	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read realistic fiction and understand setting.
	I can use language to make connections between reading and writing.
	I can plan, draft, and publish my writing.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups 
on SavvasRealize.com
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Cold Reads on SavvasRealize.com
	 LESSON 1   
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T18–T19
»	Phonological Awareness: Long and Short Vowels 
»	Phonics: Long and Short Vowels
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the
Infographic: Weekly Question T20–T21
	Listening Comprehension: Read Aloud:
“The Sandcastle” T22–T23
	Realistic Fiction T24–T25
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T25
	 (
RL.2.7, RF.2.3.a, RF.2.4.c,
SL.2.1, L.2.1.f
) LESSON 2    
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T32–T33
»	Phonics: Decode Words with Short Vowels 
»	Decode and Write Words with Short Vowels
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T33
»	High-Frequency Words
SHARED READ
	Introduce the Text T34–T51
»	Preview Vocabulary
»	Read: How Many Stars in the Sky?
	Respond and Analyze T52–T53
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T53
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T26–T27
	Handwriting: Proper Sitting Position and Proper Paper Position T26–T27
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T31
	Strategy, Intervention, and On-Level/ Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T54
	Guided Reading/Leveled Readers T57
	Strategy and Intervention Activities T54, T56
	Fluency T54, T56
	ELL Targeted Support T54, T56
	Conferring T57
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T55
	Independent Reading T57
	Literacy Activities T57

	
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop 
T334–T335
»	Explore Meeting the Author
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop 
T334–T335
	Conferences T332
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T338–T339
»	Apply Meeting the Author
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T338–T339
	Conferences T332

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spell Words with Short 
Vowels T336
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T336
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Simple Sentences T337
	 WRITING BRIDGE	
	Spelling: Teach Short Vowel Sounds T340
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Oral 
Language: Simple Sentences T341




 (
UNIT 1 WEEK 1
SUGGESTED WEEKLY PLAN
)



Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RF.2.3a, RF.2.4.a, SL.2.1.a,
SL.2.1.b, SL.2.1.c
) (
RL.2.6, RL.2.7, RF.2.3.a,
L.2.1.f, L.2.2
) (
RL.2.7, RF.2.3.a, SL.2.1,
L.2.1.f, L.2.2
)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T58–T59
»	Phonics: Decode Words with Short Vowels
»	High-Frequency Words

CLOSE READ
	Describe and Understand Setting T60–T61
	Close Read: How Many Stars in the Sky?
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T61

	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T66–T67
»	Phonics: Review Long and Short Vowels 
»	ELL Targeted Support

CLOSE READ
	Use Text Evidence T68–T69
	Close Read: How Many Stars in the Sky?
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T69
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T72–T73
»	Phonics: Spiral Review: Short Uu
»	High-Frequency Words

CLOSE READ
	Reflect and Share T74–T75
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T75
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Voice T62–T63
	Handwriting: Proper Pencil Grip T62–T63
	 

	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T65
	Strategy and Intervention Activities T64
	Fluency T64
	ELL Targeted Support T64
	Conferring T65
INDEPENDENT/COLLABORATIVE
	Independent Reading T65
	Literacy Activities T65 
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T71
	Strategy and Intervention Activities T70
	Fluency T70
	ELL Targeted Support T70
	Conferring T71
INDEPENDENT/COLLABORATIVE
	Independent Reading T71
	Literacy Activities T71
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T77
	Strategy, Intervention, and On-Level/ Advanced Activities T76
	ELL Targeted Support T76
	Conferring T77
INDEPENDENT/COLLABORATIVE
	Independent Reading T77
	Literacy Activities T77
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T77 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T342–T343
»	Explore What Good Writers Do: Genre Immersion
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T342–T343
	Conferences T332
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T346–T347
»	Apply What Good Writers Do
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T346–T347
	Conferences T332
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T350
»	Writing Club Overview
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T350–T351  [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T332

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Short Vowels T344
	Language and Conventions: Teach Simple Sentences T345
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
the CVC Pattern T348
	Language and Conventions: Practice
Simple Sentences T349
	 WRITING BRIDGE	
	Spelling: Short Vowels T352
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T352
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T353





 (
RF.2.3.a, RF.2.4, SL.2.1,
SL.2.1.b, L.2.1, L.2.1.f
)
	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING 	40–50 min.
READING BRIDGE 	5–10 min.
SMALL GROUP 	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read realistic fiction and understand its characters.
	I can use language to make connections between reading and writing.
	I can plan, draft, and publish my writing.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups 
on SavvasRealize.com
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Cold Reads on SavvasRealize.com
	 LESSON 1   
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T82–T83
»	Phonological Awareness: Listen for Long and Short Vowels
»	Phonics: Decode Words with Long Vowels
»	High-Frequency Words

GENRE & THEME
	Interact with Sources: Explore the
Infographic: Weekly Question T84–T85
	Listening Comprehension: Read Aloud:
“Troy’s Project” T86–T87
	Realistic Fiction T88–T89
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T89

	 (
RL.2.1, RF.2.3.a, RF.2.3.c,
L.2.1, L.2.1.f
) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T96–T97
»	Phonics: Decode and Write Words with Long Vowels: CVCe
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T97
»	High-Frequency Words

SHARED READ
	Introduce the Text T98–T115
»	Preview Vocabulary
»	Read: Maybe Something Beautiful
	Respond and Analyze T116–T117
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T117
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms 
T90–T91
	Handwriting: Letters Ll, Ii, and Tt T90–T91
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T95
	Strategy, Intervention, and On-Level/ Advanced Activities T94
	ELL Targeted Support T94 
	Conferring T95
INDEPENDENT/COLLABORATIVE
	Independent Reading T95
	Literacy Activities T95
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T95 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T118
	Guided Reading/Leveled Readers T121
	Strategy and Intervention Activities 
T118, T120
	Fluency T118, T120
	ELL Targeted Support T118, T120 
	Conferring T121
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T119
	Independent Reading T121
	Literacy Activities T121

	
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T358–T359
»	Explore the Writer’s Notebook
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T358–T359
	Conferences T356
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T362–T363
»	Apply the Writer's Notebook
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T362–T363
	Conferences T356

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: CVCe Words T360
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T360
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Simple Sentences T361
	 WRITING BRIDGE	
	Spelling: Teach CVCe Words T364
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Oral  Language: Subjects and Predicates T365


 (
UNIT 1 WEEK 
2
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
RL.2.3.a, RF.2.3, L.2.1,
 
L.2.1.f, L.2.2.e
) (
RL.2.1, RF.2.4, L.2.1,
L.2.1.f, L.2.2.e
) (
RF.2.3.a, W.2.6, W.2.8,
SL.2.1.b, L.2.2
)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T122–T123
»	Phonics: Decode Words with Long Vowels: CVCe	
»	High-Frequency Words

CLOSE READ
	Describe and Understand Characters 
T124–T125
	Close Read: Maybe Something Beautiful
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T125

	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T130–T131
»	Phonics: Review Long Vowels: CVCe 
»	ELL Targeted Support

CLOSE READ
	Ask and Answer Questions T132–T133
	Close Read: Maybe Something Beautiful
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T133
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T136–T137
»	Phonics: Spiral Review: Short Vowels
»	High-Frequency Words

CLOSE READ
	Reflect and Share T138–T139
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T139
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Sequence T126–T127
	Handwriting: Letters Oo, Cc, and Aa 
T126–T127
	 

	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T129
	Strategy and Intervention Activities T128
	Fluency T128
	ELL Targeted Support T128
	Conferring T129
INDEPENDENT/COLLABORATIVE
	Independent Reading T129
	Literacy Activities T129
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T130
	Strategy and Intervention Activities T134
	Fluency T129  
	ELL Targeted Support T129
	Conferring T130
INDEPENDENT/COLLABORATIVE
	Independent Reading T130
	Literacy Activities T130
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T141
	Strategy, Intervention, and On-Level/  
Advanced Activities T140
	ELL Targeted Support T140 
	Conferring T141
INDEPENDENT/COLLABORATIVE
	Independent Reading T141
	Literacy Activities T141
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T141 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T366–T367
»	Explore Tools Authors Use
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T366–T367
	Conferences T356
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T370–T371
»	Apply Tools Authors Use
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T370–T371
	Conferences T356
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T374
»	Digital Tools Authors Use
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T374–T375 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T356

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
CVCe Words T368
	Language and Conventions: Teach 
Subjects and Predicates T369
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Short Vowel Sounds T372
	Language and Conventions: Practice Subjects and Predicates T373
	 WRITING BRIDGE	
	Spelling: CVCe Words T376
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T376
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T377





 (
RL.2.5, RI.2.7, RF.2.4.c,
SL.2.1, SL.2.1.a
)
	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING 	40–50 min.
READING BRIDGE 	5–10 min.
SMALL GROUP 	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read about different places in my community.
	I can use language to make connections between reading and writing.
	I can plan, draft, and publish my writing.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on 
SavvasRealize.com
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Cold Reads on SavvasRealize.com
	 LESSON 1   
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T146–T147
»	Phonological Awareness: Make Rhyming Words
»	Phonics: Decode Consonant Blends
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the
Diagram: Weekly Question: T148–T149
	Listening Comprehension: Read Aloud:
“Helping the Community” T150–T151
	Informational Text T150–T151
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T153
	 (
RL.2.5, RI.2.2, RF.2.3, RI.2.4, L.2.1.f
) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T160–T161
»	Phonics: Decode and Write Words with Consonant Blends
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T161
»	High-Frequency Words
SHARED READ
	Introduce the Text T162–T179
»	Preview Vocabulary
»	Read: Places We Go
	Respond and Analyze T180–T181
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T181
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues T154–T155
	Handwriting: Letters Ee, Ff, and Dd 
T154–T155
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T159
	Strategy, Intervention, and On-Level/ Advanced Activities T158
	ELL Targeted Support T158 
	Conferring T159
INDEPENDENT/COLLABORATIVE
	Independent Reading T159
	Literacy Activities T159
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T159 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T182
	Guided Reading/Leveled Readers T185
	Strategy and Intervention Activities 
T182, T184
	Fluency T182, T184
	ELL Targeted Support T182, T184
	Conferring T185
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T183
	Independent Reading T185
	Literacy Activities T185

	
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T382–T383
»	Explore the Structure of Fiction
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T382–T383
	Conferences T380
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T386–T387
»	Apply the Structure of Fiction
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T386–T387
	Conferences T380

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Consonant 
Blends T384
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T384
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Subjects and Predicates T385
	 WRITING BRIDGE	
	Spelling: Teach Words with Consonant Blends T388
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Oral Language: Compound Sentences T389
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)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T186–T187
»	Phonics: Decode Words with 
Consonant Blends
»	High-Frequency Words

CLOSE READ
	Identify Main Idea T188–T189
	Close Read: Places We Go
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T189

	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T194–T195
»	Phonics: Review Consonant Blends
»	ELL Targeted Support

CLOSE READ
	Use Text Evidence T196–T197
	Close Read: Places We Go
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T197
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T200–T201
»	Phonics: Spiral Review: Long Vowels (CVCe)
»	High-Frequency Words

COMPARE TEXTS
	Reflect and Share T202–T203
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T203
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Relevant Details T190–T191
	Handwriting: Letters Gg, Jj, and Qq 
T190–T191
	 

	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T193
	Strategy and Intervention Activities T192
	Fluency T192
	ELL Targeted Support T192
	Conferring T193
INDEPENDENT/COLLABORATIVE
	Independent Reading T193
	Literacy Activities T193
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T199
	Strategy and Intervention Activities T198
	Fluency T198  
	ELL Targeted Support T198
	Conferring T199
INDEPENDENT/COLLABORATIVE
	Independent Reading T199
	Literacy Activities T199
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T205
	Strategy, Intervention, and On-Level/  
Advanced Activities T204
	ELL Targeted Support T204 
	Conferring T205
INDEPENDENT/COLLABORATIVE
	Independent Reading T205
	Literacy Activities T205
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T205 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T390–T391
»	Explore Nonfiction Text Structure
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T390–T391
	Conferences T380
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T394–T395
»	Apply Nonfiction Text Structure
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T394–T395
	Conferences T380
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T398
»	Digital Tools Authors Use
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T398–T399 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T380

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Words with Consonant Blends T392
	Language and Conventions: Teach 
Compound Sentences T393
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: CVCe 
Words T396
	Language and Conventions: Practice Compound Sentences T397
	 WRITING BRIDGE	
	Spelling: Words with Consonant Blends T400
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T400
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T401





 (
RL.2.4, RF.2.3, SL.2.1,
SL.2.1.a, L.2.2
)
	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING 	40–50 min.
READING BRIDGE 	5–10 min.
SMALL GROUP 	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read poems and understand rhyme, rhythm, and stanzas.
	I can use language to make connections between reading and writing.
	I can plan, draft, and publish my writing.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on 
SavvasRealize.com
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Cold Reads on SavvasRealize.com
	 LESSON 1   
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T210–T211
»	Phonological Awareness: Make Rhyming Words
»	Phonics: Consonant Digraphs
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Poem:
Weekly Question T212–T213
	Listening Comprehension: Read Aloud:
“A Traveling Alphabet” T214–T215
	Poetry T216–T17
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T217
	 (
RL.2.4, RF.2.3, SL.2.1,
SL.2.6, L.2.2
) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T224–T225
»	Phonics: Decode and Write Words with Consonant Digraphs
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T225
»	High-Frequency Words
SHARED READ
	Introduce the Text T226–T235
»	Preview Vocabulary
»	Read: Poetry by Gwendolyn Brooks
	Respond and Analyze T236–T237
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T237
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Word Parts 
T218–T219
	Handwriting: Letters Uu, Ss, and Bb T218–T219
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T223
	Strategy, Intervention, and On-Level/ Advanced Activities T222
	ELL Targeted Support T222 
	Conferring T223
INDEPENDENT/COLLABORATIVE
	Independent Reading T223
	Literacy Activities T223
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T223 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T238
	Guided Reading/Leveled Readers T241
	Strategy and Intervention Activities 
T238, T240
	Fluency T238, T240
	ELL Targeted Support T238, T240
	Conferring T241
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T239
	Independent Reading T241
	Literacy Activities T241

	
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T406–T407
»	Explore End Punctuation and Apostrophes
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T406–T407
	Conferences T404
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T410–T411
»	Apply End Punctuation and Apostrophes
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T410–T411
	Conferences T404

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with ch, sh, wh, 
th, ph, tch T408
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T408
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Compound Sentences T409
	 WRITING BRIDGE	
	Spelling: Teach Words with ch, sh, wh, th, ph, tch T412
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Oral Language: Sentences and End Punctuation T413
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)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T242–T243
»	Phonics: Consonant Digraphs ch, sh, wh, th, ph and Trigraph tch
»	High-Frequency Words

CLOSE READ
	Explain Patterns and Structures 
T244–T245
	Close Read: Poetry by Gwendolyn Brooks
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T245

	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T250–T251
»	Phonics: Review Consonant Digraphs
»	ELL Targeted Support

CLOSE READ
	Monitor Comprehension T252–T253
	Close Read: Poetry by Gwendolyn Brooks[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T253
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T256–257
»	Phonics: Spiral Review: Consonant Blends
»	High-Frequency Words

COMPARE TEXTS
	Reflect and Share T258–T259
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T259
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Word Choice T246–T247
	Handwriting: Letters Pp, Rr, and Nn 
T246–T247
	 

	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T249
	Strategy and Intervention Activities T248
	Fluency T248
	ELL Targeted Support T248
	Conferring T249
INDEPENDENT/COLLABORATIVE
	Independent Reading T249
	Literacy Activities T249
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T255
	Strategy and Intervention Activities T254
	Fluency T254 
	ELL Targeted Support T254
	Conferring T255
INDEPENDENT/COLLABORATIVE
	Independent Reading T254
	Literacy Activities T254
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T261
	Strategy, Intervention, and On-Level/  
Advanced Activities T260
	ELL Targeted Support T260 
	Conferring T261
INDEPENDENT/COLLABORATIVE
	Independent Reading T261
	Literacy Activities T261
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T261 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T414–T415
»	Explore Adding Details
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T414–T415
	Conferences T404
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T418–T419
»	Apply Adding Details
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T418–T419
	Conferences T404
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T422
»	Revise Drafts by Deleting Words
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T422–T423 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T404

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Words with ch, sh, wh, th, ph, tch T416
	Language and Conventions: Teach 
Sentences and End Punctuation T417
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with Consonant Blends T420
	Language and Conventions: Practice Sentences and End Punctuation T421
	 WRITING BRIDGE	
	Spelling: Words with ch, sh, wh, th, ph, tch T424
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding 
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T425





 (
RL.2.5, RF.2.4.a, W.2.5,
SL.2.1
)
	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING 	40–50 min.
READING BRIDGE 	5–10 min.
SMALL GROUP 	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read realistic fiction and understand 
its plot.
	I can use language to make connections between reading and writing.
	I can plan, draft, and publish my writing.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on 
SavvasRealize.com
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Cold Reads on SavvasRealize.com 
	Writing Workshop Performance-Based Assessment on SavvasRealize.com 
	Writing Workshop Assessment
	 LESSON 1   
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T266–T267
»	Phonological Awareness: Add and Remove Sounds
»	Phonics: Inflected endings -s, -es, 
-ed, -ing
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T268–T269
	Listening Comprehension: Read Aloud:
“A New Home” T270–T271
	Realistic Fiction T272–T273
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T273
	 (
RF.2.3.d, RF.2.4.a, SL.2.1,
SL.2.1.c, W.2.5
) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T280–T281
»	Phonics: Decode and Write Words with Inflected Endings -s, -es, -ed, -ing
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T281
»	High-Frequency Words
SHARED READ
	Introduce the Text T282–T297
»	Preview Vocabulary
»	Read: You Can’t Climb a Cactus
	Respond and Analyze T298–T299
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T299
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Oral Language T274–T275
	Handwriting: Letters Mm, Hh, and Vv T274–T275
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T279
	Strategy, Intervention, and On-Level/ Advanced Activities T278
	ELL Targeted Support T278 
	Conferring T279
INDEPENDENT/COLLABORATIVE
	Independent Reading T279
	Literacy Activities T279
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T279 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T300
	Guided Reading/Leveled Readers T303
	Strategy and Intervention Activities 
T300, T302
	Fluency T300, T302
	ELL Targeted Support T300, T302
	Conferring T303
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T301
	Independent Reading T303
	Literacy Activities T303

	
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T430–T431
»	Peer Edit
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T430–T431
	Conferences T428
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T434–T435
»	Incorporate Feedback
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T434–T435
	Conferences T428

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with -s, -es, -ed, -
-ing T432
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T432
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Sentences and End Punctuation T433
	 WRITING BRIDGE	
	Spelling: Teach Words with -s, -es, -ed,
-ing T436
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Oral Language: Use Resources to Spell Words T437
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)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T304–T305
»	Phonics: Inflected Endings -s, -es, 
-ed, -ing
»	High-Frequency Words

CLOSE READ
	Describe and Understand Plot Elements T306–T307
	Close Read: You Can’t Climb a Cactus
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T307

	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T312–T313
»	Phonics: Review Inflected Endings -s, 
-es, -ed, -ing

CLOSE READ
	Make and Confirm Predictions T314–T315
	Close Read: You Can’t Climb a Cactus
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T315
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T318–T319
»	Phonics: Spiral Review: Consonant Digraphs ch, sh, wh, th, ph, tch

COMPARE TEXTS
	Reflect and Share T320–T321
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T321
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
How Graphic Features Support Purpose 
T308–T309
	Handwriting: Letters Yy, Ww, and Xx 
T308–T309
	 

	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T311
	Strategy and Intervention Activities T310
	Fluency T310
	ELL Targeted Support T310
	Conferring T311
INDEPENDENT/COLLABORATIVE
	Independent Reading T311
	Literacy Activities T311
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T317
	Strategy and Intervention Activities T316
	Fluency T316 
	ELL Targeted Support T316
	Conferring T317
INDEPENDENT/COLLABORATIVE
	Independent Reading T317
	Literacy Activities T317
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T323
	Strategy, Intervention, and On-Level/  
Advanced Activities T322
	ELL Targeted Support T322 
	Conferring T323
INDEPENDENT/COLLABORATIVE
	Independent Reading T323
	Literacy Activities T323
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T323 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T438–T439
»	How to Write a Final Draft
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T438–T439
	Conferences T428
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T442–T443
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	Launching Writing Workshop T442–T443
	Conferences T428
	 WRITING WORKSHOP	
MINILESSON
	Launching Writing Workshop T446
»	Assessment
INDEPENDENT WRITING
	Assessment T446–T447
	Conferences T428

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Words with -s, -es, -ed, -ing T440
	Language and Conventions: Teach 
Use Resources to Spell Words T441
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
ch, sh, wh, th, ph, and tch T444
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 PROJECT FOCUS 	This week students will
	•	use search engines for research
	•	write a persuasive paragraph about a favorite place

	 LESSON 1	
T456–T457,
T458
T466–T467
 (
RI.2.9, RF.2.3.b,
RF.2.4.a, W.2.1
)
	Foundational Skills
•	Phonics: Decode Words with r-Controlled Vowels 
•	Spelling
	Compare Across Texts
•	Answer the Essential Question

	Inquire
•	Introduce Inquiry Project  
•	Read “Exploring Museums”
•	Use Academic Words

	

	 LESSON 2	
T456–T457,
T458
T468–T471
 (
RF.2.3.b, RF.2.4.a,
W.2.1, W.2.8, SL.2.3
)
	Foundational Skills
•	Phonics: Decode and Spell Words with 
r-Controlled Vowels
•	Spelling: Spell Words with ar, or, ore, oar

	Explore and Plan
•	Introduce Persuasive Writing
•	Read “Save Our Movie Theater”
	Conduct Research
•	Interview an Expert


	


	

	 LESSON 3	
T462–T463,
T459
T472–T473
 (
RF.2.3, RF.2.3.b,
RF.2.4.a, W.2.1,
W.2.8
)
	Foundational Skills
•	Phonics: r-Controlled Vowels ar, or, ore, oar
•	High-Frequency Words 
•	Spelling

	Collaborate and
Discuss
•	Analyze Student Model
•	Read “The Wonders of the Grand Canyon” 
•	Primary and Secondary Sources 
•	Persuasive Paragraph
	Refine Research
•	Examine Primary and Secondary Sources


	


	

	 LESSON 4	
T464–T465,
T459
T474–T475
 (
RF.2.3.b, W.2.5,
W.2.6, SL.2.5, L.2.2
)
	Foundational Skills
•	Phonics: Review 
r-Controlled Vowels
•	Spelling
	Extend Research
•	Include Media

	Collaborate and 
Discuss
•	Revise and Edit



	

	 LESSON 5	
T464–T465, 
T459
T476–T477
 (
RF.2.3, SL.2.1,
SL.2.1.a, SL.2.4, L.2.3
)
	Foundational Skills
•	Phonics: Spiral Review: Inflected Endings -s, -es, -ed, -ing
•	Spelling
	Celebrate and Reflect
•	Share your persuasive paragraphs
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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UNIT THEME
Nature’s Wonders
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	WEEK 3
	

	
	
	Informational Text
	
	Informational Text
	
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]Realistic Fiction
	

	
	
	A Green Kid’s Guide to Watering Plants
	
	A Home on the Prairie

	
	The Seasons of Arnold’s Apple Tree
	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Foundational Skills
	Phonological Awareness: Add and Remove Sounds
	
	Phonological Awareness: Recognize Changes in Words
	
	Phonological Awareness: Recognize Changes in Words
	

	
	
	Phonics: Contractions
	L.2.2.c
	Phonics: Long a: ai, ay, ea
	RF.2.3.b
	Phonics: Vowel Digraph ie
	RF.2.3

	
	
	High-Frequency Words: different, between, even
	RF.2.3.f
	High-Frequency Words: kind, change, air
	RF.2.3.f
	High-Frequency Words: animal, point, study
	RF.2.3.f

	
	Minilesson 
Bank
	Diagram: See How They Grow
	RI.2.7
	Infographic: Grassy Places
	RI.2.7
	Poem: Circle of Seasons
	RL.2.7

	
	
	Informational Text: A Green Kid’s Guide to Watering Plants
	RF.2.4.c
	Informational Text: A Home on the Prairie
	RI.2.5
	Realistic Fiction: The Seasons of Arnold’s Apple Tree
	SL.2.1.c

	
	
	Words That Can Relate to Gardens
	RF.2.4.c
	Words That Describe Prairies
	RI.2.5; L.2.4.e
	Words That Can Relate to Seasonal Changes
	L.2.6

	
	
	Identify Text Structure
	RI.2.3
	Use Text Features
	RI.2.5
	Understand Setting and Plot
	RL.2.7

	
	
	Ask and Answer Questions
	RI.2.1
	Make and Confirm Predictions
	RI.2.5
	Visualize Details
	RL.2.10

	
	
	Talk About It: Oral Response to Informational Text
	SL.2.1.a; SL.2.1.b
	Write to Sources: Respond to Informational Text
	W.2.2; W.2.8
	Talk About It: Oral Response to Literature
	SL.2.1.a

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.2.5
	Synonyms
	L.2.5
	Context Clues
	RF.2.4.c; L.2.4.a

	
	
	Handwriting
	Write the Letters Kk and Zz; Write Numerals 1–10
	L.1.1.a
	Practice Cursive Swing- Ups and Loops
	L.1.1.a
	Practice Cursive Swoops and Waves
	L.1.1.a

	
	
	Read Like a Writer/Write for a Reader
	Text Structure
	RI.2.3
	Descriptive Words
	SL.2.1
	Sentence Lengths
	L.2.5.a

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Informational List Articles
	W.2.2
	Topic and Main Idea
	W.2.2
	Introduction and Conclusion
	W.2.2

	
	
	Informational List Articles
	W.2.2
	Develop Details
	W.2.2
	Organize Details
	W.2.2

	
	
	Informational List Articles
	W.2.2
	Develop Details
	W.2.2
	Organize Details
	W.2.2

	
	
	Generate Ideas for List Articles
	W.2.2
	Graphic Features
	W.2.2
	Text Features
	W.2.2

	
	
	Plan Your List Article
	SL.2.1
	Graphic Features
	W.2.2
	Text Features
	W.2.2

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Contractions
	L.2.2.c
	Spell Words with Long a:
ai, ay, ea
	RF.2.3.b
	Spell Words with ie
	RF.2.3.b

	
	
	Language & Conventions
	Singular and Plural Nouns
	L.2.1
	Irregular Plural Nouns
	L.2.1.b
	Common and Proper Nouns
	L.2.2.a
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Essential Question
)
What patterns do we see in nature?
	WEEK 4
	
	WEEK 5
	

	Fiction
	
	Informational Text
	

	What’s in the Egg, Little Pip?
	
	
Amazing Migrations
	

	
	CCSS
	
	CCSS

	Phonological Awareness: Change Sounds in Base Words
	
	Phonological Awareness: Change the Sounds in Base Words
	

	Phonics: Long e: ee, ea, 
ey, y
	RF.2.3; RF.2.3.a
	Phonics: Long o: o, oa, ow
	RF.2.3.a

	High-Frequency Words: letter, answer, page
	RF.2.3.f
	High-Frequency Words: near, food, try
	RF.2.3.f

	Infographic: Animals and Their Young
	RI.2.5
	Infographic: Animals on the Move
	RL.2.5

	Fiction: What’s in the Egg, Little Pip?
	RF.2.4.a
	Informational Text: Amazing Migrations
	RL.2.2

	Words That Can Describe Animal Behaviors
	L.2.5
	Words That Can Relate to Animal Migration
	L.2.4.e

	Describe and Understand Characters
	RL.2.3
	Use Text Features
	RL.2.5

	Make Inferences
	RL.2.3
	Determine Key Ideas
	RL.2.2

	Write to Sources: Respond to Text
	W.2.2
	Talk About It: Oral Response to Informational Text
	SL.2.1.a

	Word Parts
	L.2.4.c
	Oral Language
	L.2.6

	Write the Cursive Letters i, t, u, and w
	L.1.1.a
	Write the Cursive Letters e, l, b, and h
	L.1.1.a

	Dialogue
	RL.2.6
	Graphic Features
	RI.2.5

	Writer’s Craft
	Publish, Celebrate, and Assess

	Complete Sentences with Subject-Verb Agreement
	L.2.1
	Edit for Commas in a Series
	L.2.2

	Nouns
	L.2.1
	Edit for Complete Sentences with Subject- Verb Agreement
	L.2.3

	Nouns
	L.2.1.b
	Prepare for Celebration
	W.2.6

	Prepositions and Prepositional Phrases
	L.2.1
	Celebration
	W.2.6

	Prepositions and Prepositional Phrases
	L.2.1
	Assessment
	W.2.8

	Spell Words with Long e: ee, ea, ey, y
	L.2.1
	Spell Words with Long o: 
o, oa, ow
	RF.2.3.b

	Possessive Nouns
	L.2.2.c
	Collective Nouns
	L.2.1.a
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Tree Bark
	

	
	CCSS

	Foundational Skills

	Phonics: Compound Words
	L.2.4.d

	High-Frequency Words: country, city, school
	RF.2.3.f

	Spelling: Spell Compound Words
	L.2.4.d

	Compare Across Texts: “Nature’s Wonders”
	RI.2.9

	Inquire: Tree Bark
	W.2.7

	Leveled Research Articles
	RF.2.4.a

	Academic Words
	L.2.6

	Explore and Plan: Introduce Informational Writing
	W.2.2

	Conduct Research: Library Database and Books
	W.2.2

	Collaborate and Discuss: Sample Fact Sheet
	W.2.8

	Paraphrasing and Plagiarism
	W.2.7

	Extend Research: Create a Poster with Images
	W.2.2

	Revise and Edit
	W.2.5

	Celebrate and Reflect
	SL.2.6
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read informational text and understand text structure.
	I can use language to make connections between reading and writing.
	I can use elements of informational text to write.
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
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Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T18–T19
»	Phonological Awareness: Add and Remove Sounds
»	Phonics: Contractions
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Diagram: Weekly Question T20–T21
	Listening Comprehension: Read Aloud: “Patterns on the Prairie” T22–T23
	Informational Text T24–T25 
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T33
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.
2
.
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, 
RI
.
2
.
8
,
L.2.2.c, L
.
2
.
4.a
) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T32–T33
»	Phonics: Decode and Write Contractions
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T33
»	High-Frequency Words
GENRE & THEME
	Introduce the Text T34–T53
»	Preview Vocabulary
»	Read: A Green Kid’s Guide to Watering Plants
	Respond and Analyze T54–T55
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T55
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T26–T27
	Handwriting: Letters Kk and Zz T26–T27
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T56
	Guided Reading/Leveled Readers T59
	Strategy and Intervention Activities T56, T58
	Fluency T56, T58
	ELL Targeted Support T56, T58
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T57
	Independent Reading T59
	Literacy Activities T59

	
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T352–T353
»	List Article
»	Share Back
INDEPENDENT WRITING
	List Article T352–T353
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T356–T357
»	List Article: Main Idea and Details
»	Share Back
INDEPENDENT WRITING
	List Article T356–T357
	Conferences T350

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Contractions T354
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	Language and Conventions: Spiral Review: Use Resources to Spell Words T355
	 WRITING BRIDGE	
	Spelling: Teach Contractions T358
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	Language and Conventions: Oral Language: Singular and Plural Nouns T359
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T60–T61
»	Phonics: Contractions
»	High-Frequency Words
CLOSE READ
	Identify Text Structure T62–T63
	Close Read: A Green Kid’s Guide to Watering Plants
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T63
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T68–T69
»	Phonics: Review Contractions
»	ELL Targeted Support
CLOSE READ
	Ask and Answer Questions T70–T71
	Close Read: A Green Kid’s Guide to Watering Plants
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T71
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T74–T75
»	Phonics: Spiral Review: Inflected Endings
»	ELL Targeted Support
COMPARE TEXTS
	Reflect and Share T76–T77
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T77
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Text Structure T64–T65
	Handwriting: Numerals 1–10 T64–T65
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T67
	Strategy and Intervention Activities T66
	Fluency T66
	ELL Targeted Support T66
	Conferring T67
INDEPENDENT/COLLABORATIVE
	Independent Reading T67
	Literacy Activities T67
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T73
	Strategy and Intervention Activities T72
	Fluency T72
	ELL Targeted Support T72
	Conferring T73
INDEPENDENT/COLLABORATIVE
	Independent Reading T73
	Literacy Activities T73
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T79
	Strategy, Intervention, and On-Level/
Advanced Activities T78
	ELL Targeted Support T78
	Conferring T79
INDEPENDENT/COLLABORATIVE
	Independent Reading T79
	Literacy Activities T79
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T79 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T360–T361
»	List Article: Features and Graphics
»	Share Back
INDEPENDENT WRITING
	List Article T360–T361
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T364–T365
»	Generate Ideas
»	Share Back
INDEPENDENT WRITING
	List Article T364–T365
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T368
»	Plan Your List Article
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T368–T369 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T350

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Contractions T362
	Language and Conventions: Teach Singular and Plural Nouns T363


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
ar, or, ore, and oar T366
	Language and Conventions: Practice 
Singular and Plural Nouns T367


	 WRITING BRIDGE	
	Spelling: Contractions T370
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T370
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T371
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read informational text and understand text structure.
	I can use language to make connections between reading and writing.
	I can use elements of informational text 
to write.
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T84–T85
»	Phonological Awareness: Changes in Words
»	Phonics: Vowel Digraphs al, ay, ea
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T86–T87
	Listening Comprehension: Read Aloud: “The Art of Gardens” T88–T89
	Informational Text T90–T91
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T98–T99
»	Phonics: Decode and Write Words with Vowel Digraphs ai, ay, ea
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T99
»	High-Frequency Words
SHARED READ
	Introduce the Text T100–T113
»	Preview Vocabulary
»	Read: A Home on the Prairie
	Respond and Analyze T114–T115
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T115
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Synonyms 
T92–T93
	Handwriting: Cursive Starter: Swing Ups T92–T93
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T97
	Strategy, Intervention, and On-Level/
Advanced Activities T96
	ELL Targeted Support T96
	Conferring T97
INDEPENDENT/COLLABORATIVE
	Independent Reading T97
	Literacy Activities T97
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T97 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T116
	Guided Reading/Leveled Readers T119
	Strategy and Intervention Activities T116, T118
	Fluency T116, T118
	ELL Targeted Support T116, T118
	Conferring T119
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T117
	Independent Reading T119
	Literacy Activities T119

	
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T376–T377
»	Topic and Main Idea
»	Share Back
INDEPENDENT WRITING
	List Article T376–T377
	Conferences T374
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T380–T381
»	Explore Develop Details
»	Share Back
INDEPENDENT WRITING
	List Article T380–T381
	Conferences T374

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Long a: ai, ay, ea T378
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	Language and Conventions: Spiral Review: Singular and Plural Nouns T379
	 WRITING BRIDGE	
	Spelling: Teach Words with Long a: ai, ay, ea T382
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	Language and Conventions: Oral Language: Irregular Plural Nouns T383
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)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T120–T121
»	Phonics: Vowel Digraphs ai, ay, ea
»	High-Frequency Words
CLOSE READ
	Use Text Features and Graphics 
T122–T123
	Close Read: A Home on the Prairie
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T123
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T128–T129
»	Phonics: Review Vowel Digraphs 
ai, ay, ea
»	ELL Targeted Support
CLOSE READ
	Make and Confirm Predications T130–T131
	Close Read: A Home on the Prairie
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T131
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T134–T135
»	Phonics: Spiral Review: Contractions
»	ELL Targeted Support
COMPARE TEXTS
	Reflect and Share T136–T137
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T137
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Descriptive Language T124–T125
	Handwriting: Cursive Starter: Loops 
T124–T125
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T127
	Strategy and Intervention Activities T126
	Fluency T126
	ELL Targeted Support T126
	Conferring T127
INDEPENDENT/COLLABORATIVE
	Independent Reading T127
	Literacy Activities T127
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T133
	Strategy and Intervention Activities T132
	Fluency T132
	ELL Targeted Support T132
	Conferring T133
INDEPENDENT/COLLABORATIVE
	Independent Reading T133
	Literacy Activities T133
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T139
	Strategy, Intervention, and On-Level/
Advanced Activities T138
	ELL Targeted Support T138
	Conferring T138
INDEPENDENT/COLLABORATIVE
	Independent Reading T139
	Literacy Activities T139
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T139 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T384–T385
»	Apply Develop Details
»	Share Back
INDEPENDENT WRITING
	List Article T384–T385
	Conferences T374
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T388–T389
»	Explore Features and Graphics
»	Share Back
INDEPENDENT WRITING
	List Article T388–T389
	Conferences T374
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T392
»	Apply Features and Graphics
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png] CLUB T392–T393 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T374

	 WRITING BRIDGE	
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	Spelling: Review and More Practice: 
Words with Long a: ai, ay, ea T386
	Language and Conventions: Teach Irregular Plural Nouns T387


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Contractions 
T390
	Language and Conventions: Practice 
Irregular Plural Nouns T391


	 WRITING BRIDGE	
	Spelling: Words with Long a: ai, ay, ea T394
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read a story to learn more about patterns in nature.
	I can use language to make connections between reading and writing.
	I can use elements of informational text 
to write.
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T144–T145
»	Phonological Awareness: Recognize Changes in Words
»	Phonics: Vowel Digraph ie
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Poem: Weekly Question T146–T147
	Listening Comprehension: Read Aloud: “Season to Season” T148–T149
	Realistic Fiction T150–T151
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T151
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T158–T159
»	Phonics: Decode and Write Words with Vowel Digraph ie
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T159
»	High-Frequency Words
SHARED READ
	Introduce the Text T160–T183
»	Preview Vocabulary
»	Read: The Seasons of Arnold’s Apple Tree
	Respond and Analyze T184–T185
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T185
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues
T152–T153
	Handwriting: Cursive Starter: Swoops T152–T153
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T157
	Strategy, Intervention, and On-Level/
Advanced Activities T156
	ELL Targeted Support T156
	Conferring T157
INDEPENDENT/COLLABORATIVE
	Independent Reading T157
	Literacy Activities T157
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T157 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T186
	Guided Reading/Leveled Readers T189
	Strategy and Intervention Activities T186, T188
	Fluency T186, T188
	ELL Targeted Support T186, T188
	Conferring T189
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T187
	Independent Reading T189
	Literacy Activities T189

	
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T400–T401
»	Introduction and Conclusion
»	Share Back
INDEPENDENT WRITING
	List Article T400–T401
	Conferences T398
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T404–T405
»	Explore Organize Details
»	Share Back
INDEPENDENT WRITING
	List Article T404–T405
	Conferences T398

	
	 WRITING BRIDGE	
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	Spelling: Words with ie T402
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	Spelling: Teach Words with ie T406
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T190–T191
»	Phonics: Vowel Digraph ie
»	High-Frequency Words
CLOSE READ
	Understand Setting and Plot T192–T193
	Close Read: The Seasons of Arnold’s Apple Tree
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T193
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T198–T199
»	Phonics: Review Vowel Digraph ie
»	ELL Targeted Support
CLOSE READ
	Visualize Details T200–T201
	Close Read: The Seasons of Arnold’s Apple Tree
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T201
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T204–T205
»	Phonics: Spiral Review: Vowel Digraphs ai, ay, ea
»	ELL Targeted Support
COMPARE TEXTS
	Reflect and Share T206–T207
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T207
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Sentence Lengths T194–T195
	Handwriting: Cursive Starter: Waves 
T194–T195
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T197
	Strategy and Intervention Activities T196
	Fluency T196
	ELL Targeted Support T196
	Conferring T197
INDEPENDENT/COLLABORATIVE
	Independent Reading T197
	Literacy Activities T197
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T203
	Strategy and Intervention Activities T202
	Fluency T202
	ELL Targeted Support T202
	Conferring T203
INDEPENDENT/COLLABORATIVE
	Independent Reading T203
	Literacy Activities T203
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T209
	Strategy, Intervention, and On-Level/
Advanced Activities T208
	ELL Targeted Support T208
	Conferring T209
INDEPENDENT/COLLABORATIVE
	Independent Reading T209
	Literacy Activities T209
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T209 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T408–T409
»	Apply Organize Details
»	Share Back
INDEPENDENT WRITING
	List Article T408–T409
	Conferences T398
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T412–T413
»	Explore Text Features
»	Share Back
INDEPENDENT WRITING
	List Article T412–T413
	Conferences T398
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T416
»	Apply Text Features
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png] CLUB T416–T417 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T398

	 WRITING BRIDGE	
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	Spelling: Review and More Practice: 
Words with ie T410
	Language and Conventions: Teach Common and Proper Nouns T411


	 WRITING BRIDGE	
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	Spelling: Spiral Review: Vowel Digraphs 
ai, ay, ea T414
	Language and Conventions: Practice 
Common and Proper Nouns T415


	 WRITING BRIDGE	
	Spelling: Words with ie T418
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING 	40–50 min.
READING BRIDGE 	5–10 min.
SMALL GROUP 	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read about patterns in nature by reading a story about a penguin.
	I can use language to make connections between reading and writing informational texts.
	I can use elements of informational text to write a list article.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups 
on SavvasRealize.com
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Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Cold Reads on SavvasRealize.com
	 LESSON 1   
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T214–T215
»	Phonological Awareness: Manipulate Sounds
»	Decode Words with Long e: ee, 
ea, ey, y
»	High-Frequency Words

GENRE & THEME
	Interact with Sources: Explore the
Infographic: Weekly Question T216–T217
	Listening Comprehension: Read Aloud:
“Joey and His Pouch” T218–T219
	Fiction T220–T221
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T221
	 (
RL.2.3, RF.2.3.c, RF.2.3.f,
RF.2.4.a, L.2.3
) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T228–T229
»	Phonics: Decode and Write Words with Long e
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T229
»	High-Frequency Words

SHARED READ
	Introduce the Text T230–T253
»	Preview Vocabulary
»	Read: What’s in the Egg, Little Pip?
	Respond and Analyze T254–T255
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T255
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Word Parts 
T222–T223
	Handwriting: Letters i and t T222–T223
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T227
	Strategy, Intervention, and On-Level/ Advanced Activities T226
	ELL Targeted Support T226
	Conferring T227
INDEPENDENT/COLLABORATIVE
	Independent Reading T227
	Literacy Activities T227
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T227 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T256
	Guided Reading/Leveled Readers T259
	Strategy and Intervention Activities 
T256, T258
	Fluency T256, T258  
	ELL Targeted Support T256, T258
	Conferring T259
INDEPENDENT/COLLABORATIVE
	Word Work Activities and Decodable Reader T257
	Independent Reading T259
	Literacy Activities T259

	
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T424–T425
»	Complete Sentences with Subject-Verb Agreement
»	Share Back
INDEPENDENT WRITING
	List Article T425–T426
	Conferences T422
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T428–T429
»	Explore Nouns
»	Share Back
INDEPENDENT WRITING
	List Article T428–T429
	Conferences T422

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Long e: ee,
ea, ey, y T426
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T426
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	Language and Conventions: Spiral Review: Common and Proper Nouns T427
	 WRITING BRIDGE	
	Spelling: Teach Words with Long e: ee, ea, ey, y T430
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T260–T261
»	Phonics: Words with Long e: 
ee, ea, ey, y
»	High-Frequency Words

CLOSE READ
	Describe and Understand Characters 
T262–T263
	Close Read: What’s in the Egg, Little Pip?
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T263

	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T268–T269
»	Phonics: Review Words with Long e: ee, ea, ey, y 
»	ELL Targeted Support

CLOSE READ
	Make Inferences T270–T271
	Close Read: What’s in the Egg, Little Pip?
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T271
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T274–T275
»	Phonics: Spiral Review: Vowel 
Digraph ie
»	ELL Targeted Support

COMPARE TEXTS
	Reflect and Share T276–T277
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T277
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Dialogue T264–T265
	Handwriting: Letters u and w T264–T265
	 

	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T267
	Strategy and Intervention Activities T266
	Fluency T266  
	ELL Targeted Support T266
	Conferring T267
INDEPENDENT/COLLABORATIVE
	Independent Reading T267
	Literacy Activities T267 

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T273
	Strategy and Intervention Activities T272
	Fluency T272 
	ELL Targeted Support T272
	Conferring T273
INDEPENDENT/COLLABORATIVE
	Independent Reading T273
	Literacy Activities T273
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T279
	Strategy, Intervention, and On-Level/ Advanced Activities T278
	ELL Targeted Support T278
	Conferring T279
INDEPENDENT/COLLABORATIVE
	Independent Reading T279
	Literacy Activities T279
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T279 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T432–T433
»	Apply Nouns
»	Share Back
INDEPENDENT WRITING
	List Article T432–T433
	Conferences T422
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T436–T437
»	Explore Prepositions and Prepositional Phrases
»	Share Back
INDEPENDENT WRITING
	List Article T436–T437
	Conferences T422
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T440
»	Apply Prepositions and Prepositional Phrases
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T440–T441 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T422

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Words with Long e: ee, ea, ey, y T434
	Language and Conventions: Teach Possessive Nouns T435
	 WRITING BRIDGE	
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	Spelling: Spiral Review: Vowel 
Digraph ie T438
	Language and Conventions: Practice Possessive Nouns T439
	 WRITING BRIDGE	
	Spelling: Words with Long e: ee, ea, ey, y
T442
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING 	40–50 min.
READING BRIDGE 	5–10 min.
SMALL GROUP 	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can use text features to understand a topic.
	I can use language to make connections between reading and writing.
	I can use elements of informational text to write.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on 
SavvasRealize.com
	Cold Reads on SavvasRealize.com
	Writing Workshop Performance-Based Assessment on SavvasRealize.com
 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
)	Writing Workshop Assessment
	 LESSON 1   
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T284–T285
»	Phonological Awareness: Change Sounds in Base Words
»	Phonics: Words with Long o: o, oa, ow
»		High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the
Infographic Weekly Question T286–T287
	Listening Comprehension: Read Aloud:
“When Animals Do Not Migrate” 
T288–T289
	Informational Text T290–T291
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T291
	 (
RI.2.1, RI.2.4, RF.2.3.b,
L.2.1.a, L.2.3
) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T298–T299
»	Phonics: Decode and Write Words with Long o: o, oa, ow
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T299
»	High-Frequency Words
SHARED READ
	Introduce the Text T300–T315
»	Preview Vocabulary
»	Read: Amazing Migrations: Butterflies, Bats, and Birds
	Respond and Analyze T316–T317
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T317
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Oral Language T292–T293
	Handwriting: Letters e and l T292–T293
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T297
	Strategy, Intervention, and On-Level/ Advanced Activities T296
	ELL Targeted Support T296
	Conferring T297
INDEPENDENT/COLLABORATIVE
	Independent Reading T297
	Literacy Activities T297
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T297 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T318
	Guided Reading/Leveled Readers T321
	Strategy and Intervention Activities 
T318, T320
	Fluency T318, T320
	ELL Targeted Support T318, T320
	Conferring T321
INDEPENDENT/COLLABORATIVE
	Word Work Activities and Decodable Reader T319
	Independent Reading T321
	Literacy Activities T321

	
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T448–T449
»	Edit for Commas in a Series
»	Share Back
INDEPENDENT WRITING
	List Article T448–T449
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T452–T453
»	Edit for Complete Sentence 
Subject-Verb Agreement
»	Share Back
INDEPENDENT WRITING
	List Article T452–T453
	Conferences T446

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Long o: o, oa, 
ow T450
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T450
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Possessive Nouns T451
	 WRITING BRIDGE	
	Spelling: Teach Words with Long o: o, oa, ow T454
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Oral Language: Collective Nouns T455
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) (
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L.2.1.a, W.2.8
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RF.2.3.b, SL.2.1, SL.2.1.a,
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)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T322–T323
»	Phonics: Words with Long o: o, oa, ow
»	High-Frequency Words

CLOSE READ
	Use Text Features T324–T325
	Close Read: Amazing Migrations: Butterflies, Bats, and Birds
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T325

	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T330–T331
»	Phonics: Review Words with Long o: o, oa, ow
»	ELL Targeted Support

CLOSE READ
	Determine Key Ideas T332–T333
	Close Read: Amazing Migrations: Butterflies, Bats, and Birds
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T333
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T336–T337
»	Phonics: Spiral Review: Vowel Long e: ee, ea, ey, y
»	ELL Targeted Support

COMPARE TEXTS
	Reflect and Share T338–T339
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T339
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Graphic Features T326–T327
	Handwriting: Letters b and h T326–T327
	 

	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T329
	Strategy and Intervention Activities T328
	Fluency T328  
	ELL Targeted Support T328
	Conferring T329
INDEPENDENT/COLLABORATIVE
	Independent Reading T329
	Literacy Activities T329

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T335
	Strategy and Intervention Activities T334
	Fluency T334 
	ELL Targeted Support T334
	Conferring T335
INDEPENDENT/COLLABORATIVE
	Independent Reading T335
	Literacy Activities T335
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T341
	Strategy, Intervention, and On-Level/ Advanced Activities T340
	ELL Targeted Support T340
	Conferring T341
INDEPENDENT/COLLABORATIVE
	Independent Reading T341
	Literacy Activities T341
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T341 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T456–T457
»	Prepare for Celebration
»	Share Back
INDEPENDENT WRITING
	List Article T456–T457
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T460–T461
»	Celebrate
»	Share Back
INDEPENDENT WRITING
	List Article T460–T461
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Informational: List Article T464
»	Assessment
INDEPENDENT WRITING
	Assessment T464–T465
	Conferences T446

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Words with Long o: o, oa, ow T458
	Language and Conventions: Teach Collective Nouns T459
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words 
with Long e: ee, ea, ey, y T462
	Language and Conventions: Practice Collective Nouns T463
	 WRITING BRIDGE	
	Spelling: Words with Long o: o, oa, ow T466
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T466
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T467





 PROJECT FOCUS 	This week students will
[bookmark: _GoBack]	•	research trees and the patterns in tree bark.
	•	write a Fact Sheet about the pattern the tree bark makes.

	 LESSON 1	
T474–T475,
T476
T484–T485 (
RI.2.9, W.2.7,
SL.2.1, L.2.4.d,
L.2.6
)
	Foundational Skills
•	Phonics: Decode Compound Words
•	Spelling
	Compare Across Texts
•	Answer the Essential Question

	Inquire
•	Introduce the Project  
•	Read “Looking at Tree Bark”
•	Learn about tree rubbings
•	Use Academic Vocabulary

	

	 LESSON 2	
T474–T475,
T476
T486–T489
 (
RF.2.3, RF.2.4,
W.2.2, W.2.7, L.2.4.d
)
	Foundational Skills
•	Phonics: Decode and Spell Compound Words
•	Spelling: Spell Compound Words
	Explore and Plan
•	Introduce Informational Writing
•	Read “Tidal Patterns”
	Conduct Research
•	Library Database and Books
•	Collect tree rubbings or bark images


	

	 LESSON 3	
T480–T481,
T477
T490–T491
 (
RF.2.3, RF.2.4,
W.2.7, L.2.4.d
)
	Foundational Skills
•	Phonics: Compound Words
•	High-Frequency Words
•	Spelling

	Collaborate and
Discuss
•	Sample Fact Sheet
•	Read “Nature’s Skyscrapers”
	Refine Research
•	Paraphrasing and Plagiarism

	

	 LESSON 4	
T482–T483,
T477
T492–T493
 (
RF.2.3, W.2.2, W.2.5,
W.2.8, L.2.4.d
)
	Foundational Skills
•	Phonics: Review Compound Words
•	Spelling

	Extend Research
•	Create a Poster with Images
	Collaborate and Discuss
•	Revise and Edit

	

	 LESSON 5	
T482–T483, 
T477
T494–T495
 (
RF.2.3, SL.2.6,
W.2.7, SL.2.6
)
	Foundational Skills
•	Phonics: Spiral Review Words with Long o, Spelled o, oa, ow
•	Spelling
	Celebrate and Reflect
•	Present projects
•	Reflect on projects
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing




[image: Mac:Users:santosh:Desktop:Untitled-1.png][image: Mac:Users:santosh:Desktop:Untitled-1.png] (
NATURE’S WONDERS
)[image: Mac:Users:santosh:Desktop:Untitled-1.png] (
UNIT 
2
 
WEEK
 
6
WEEKLY PLAN
NER
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
UNIT THEME
Our Traditions
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	Traditional 
Tales: Fables
	
	Traditional Tales: Legend
	
	Traditional Tales: Folktales
	

	
	
	

Fables
	
	
The Legend of the Lady Slipper
	
	Interstellar Cinderella 
and Cendrillon: An Island Cinderella

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Foundational Skills
	Phonics: Long i: i, ie, i_e, igh, y
	RF.2.3.a
	Phonics: Comparative Endings
	RF.2.3.d
	Phonics: r-Controlled Vowels: er, ir, ur
	RF.2.3

	
	
	High-Frequency Words: eyes, earth, thought
	RF.2.3.f
	High-Frequency Words: along, few, head
	RF.2.3.f
	High-Frequency Words: something, example, paper
	SL.2.4

	
	
	Decodable Text: Rabbit’s Kite
	RF.2.3
	Decodable Text: No Help 
at All!
	RF.2.3.f
	Decodable Text: Perfect!
	RF.2.4

	
	Minilesson 
Bank
	Infographic: Traditional Tales
	RL.2.2
	Infographic: The World of the Storyteller
	SL.2.1
	Infographic: Telling a Story
	SL.2.4

	
	
	Fable: Fables
	RL.2.2
	Legend: The Legend of the Lady Slipper
	RL.2.3; RL.2.7
	Folktales: Interstellar Cinderella and Cendrillon: An Island Cinderella
	SL.2.4

	
	
	Words That Can Tell About Feelings
	RL.2.2
	Words That Can Tell About Feelings and Objects
	L.2.5
	Words That Can Describe and Name Objects and an Action
	RL.2.9

	
	
	Identify Theme
	RL.2.2
	Discuss Author’s Purpose
	RL.2.7
	Compare and Contrast Stories
	RL.2.9

	
	
	Determine Key Ideas
	RL.2.1
	Make Connections
	RL.2.10
	Visualize Details
	RL.2.7

	
	
	Talk About It: Respond to Literature
	RL.2.1
	Write to Sources: Respond to Literature
	W.2.1
	Talk About It: Respond to Literature
	RL.2.2

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.1.1.a
	Synonyms and Antonyms
	L.2.5
	Context Clues
	L.2.4.a

	
	
	Handwriting
	Write the Cursive Letters f, k, r, and s
	L.1.1.a
	Write the Cursive Letters j, p, a, and d
	L.1.1.a
	Write Words Using Appropriate Strokes; Write the Cursive Letters g and o
	L.1.1.a

	
	
	Read Like a Writer/Write for a Reader
	Author’s Purpose
	RL.2.2
	Story Structure
	RL.2.5; W.2.3
	Word Choice
	RL.2.7

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Poetry
	L.2.6
	Imagery
	L.2.6
	Simile
	L.2.5

	
	
	Poetry
	RL.2.4
	Sensory Details
	L.2.6
	Alliteration
	RL.2.4

	
	
	Poetry
	RL.2.4
	Sensory Details
	L.2.6
	Alliteration
	RL.2.4

	
	
	Generate Ideas
	L.2.6
	Word Choice
	L.2.6
	Audio Recording
	SL.2.5

	
	
	Plan Your Poem
	L.2.6
	Word Choice
	L.2.6
	Audio Recording
	SL.2.5

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Words with Long i: i, ie, i_e, igh, y
	RF.2.3.e
	Spell Words with Comparative Endings
	L.2.2
	Spell Words with 
r-Controlled Vowels er, ir, ur
	L.2.2

	
	
	Language & Conventions
	Present-Tense Verbs
	L.2.3
	Past- and Future-Tense Verbs
	L.2.3
	Irregular Verbs
	L.2.1.c
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 (
Essential Question
)
What makes a tradition?
	WEEK 4
	
	WEEK 5
	

	
Informational Text
	
	Realistic Fiction/ Procedural Text
	

	

The Abenaki
	
	

My Food, Your Food
	

	
	CCSS
	
	CCSS

	Phonics: Diphthongs ou, ow, oi, oy
	RF.2.3.b
	Phonics: Vowel Teams oo, ue, ew, ui
	RF.2.3.a

	High-Frequency Words: often, important, took
	RF.2.3.f
	High-Frequency Words: hear, idea, enough
	RF.2.3.f

	Decodable Text: The Story
	RF.2.3
	Decodable Text: Sue’s 
New School
	RF.2.3

	Infographic: The Wabanaki
	RI.2.1
	Infographic: Traditional Foods
	RI.2.5

	Informational Text: The Abenaki
	RI.2.10
	Realistic Fiction/Procedural Text: My Food, Your Food
	RI.2.10

	Words That Can Relate to Traditions
	L.2.4.e; L.2.6
	Words That Can Tell About Food
	L.2.6

	Discuss Author’s Purpose
	RI.2.6
	Understand Text Features
	RI.2.5

	Make Connections
	RI.2.10
	Make Inferences
	RI.2.10

	Write to Sources: Respond to Informational Text
	W.2.2
	Talk About It: Respond to Text
	L.2.3

	Word Parts
	L.2.4.c
	Oral Language
	L.2.6

	Write the Cursive Letters c, q, n, and m
	L.1.1.a
	Write the Cursive Letters y, x, v, and z
	L.1.1.a

	Text Structure
	W.2.2
	Organizing Information
	RL.2.5

	Writer’s Craft
	Publish, Celebrate, and Assess

	Revise Drafts by Rearranging Words
	L.2.1.f
	Edit for Nouns
	L.2.1

	Edit Adjectives and Articles
	L.2.1.e
	Edit for Prepositions and Prepositional Phrases
	L.2.1

	Edit Adjectives and Articles
	L.2.1.e
	Prepare for Celebration
	RF.2.4.b

	Edit for Past, Present, and Future Verb Tenses
	L.2.1
	Publish and Celebrate
	RF.2.4.b

	Edit for Past, Present, and Future Verb Tenses
	L.2.1
	Assessment
	L.2.2

	Spell Words with ou, ow, 
oi, oy
	RF.2.3.b; L.2.2.d
	Spell Words with Vowel Teams oo, ue, ew, ui
	RF.2.3.b

	Subject-Verb Agreement
	L.2.3
	Adverbs
	L.2.1.e


	WEEK 6
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Inquiry and Research
	

	

Celebrate at School!
	

	
	CCSS

	FOUNDATIONAL SKILLS

	Phonics: /s/ Spelled c; /j/ Spelled g or dge
	L.2.2.d

	High-Frequency Words: group, book, almost
	RF.2.3

	Spelling: Spell Words with /s/ Spelled c and /j/ Spelled g or dge
	L.2.1

	Compare Across Texts: “Our Traditions”
	SL.2.1

	Inquire: Celebrate at School!
	W.2.1

	Leveled Research Articles
	RF.2.4.a

	Academic Words
	L.2.4

	Explore and Plan: Explore Opinion Writing
	W.2.1

	Conduct Research: Search Online
	W.2.6

	Collaborate and Discuss: Analyze Student Model
	W.2.1

	Cite Sources
	W.2.1

	Extend Research: Write a Thank You Note
	W.2.5

	Revise and Edit
	W.2.5

	Celebrate and Reflect
	SL.2.1.c




 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
) (
R
L
.
2
.
2
, 
RL
.
2
.
4
, 
RF
.
2
.
3.a
,
L.2.5, SL.2.1
)
	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read fables and identify their themes.
	I can use language to make connections between reading and writing.
	I can use figurative language and sound devices to write poetry.
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T18–T19
»	Phonics: Long i: i, ie, i_e, igh, y
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T20–T21
	Listening Comprehension: Read Aloud: “The Lion and the Mouse” T22–T23
	Traditional Tales: Fables T24–T25
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T25
	 (
R
L
.
2
.
2
, 
RL
.
2
.
4
, 
RL
.
2
.
5
,
RF.2.3, L
.
2
.
3
) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T32–T33
»	Phonics: Decode and Write Words with Long i: i, ie, i_e, igh, y
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T33
»	High-Frequency Words
SHARED READ
	Introduce the Text T34–T47
»	Preview Vocabulary
»	Read: Fables
	Respond and Analyze T48–T49
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T49
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T26–T27
	Handwriting: Letters f and k T26–T27
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T50
	Guided Reading/Leveled Readers T53
	Strategy and Intervention Activities T50, T52
	Fluency T50, T52
	ELL Targeted Support T50, T52
	Conferring T53
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T51
	Independent Reading T53
	Literacy Activities T53

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T352–T353
»	Poetry
»	Share Back
INDEPENDENT WRITING
	Poetry T352–T353
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Poetry T366–T367
»	Poetry: What It Sounds Like
»	Share Back
INDEPENDENT WRITING
	Poetry T356–T357
	Conferences T350

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Long i T354
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T354
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Collective Nouns T355
	 WRITING BRIDGE	
	Spelling: Teach Words with Long i T358
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	Language and Conventions: Oral Language: Present-Tense Verbs T359
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R
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.
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.
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.
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.
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,
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.
2
.
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2
.
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R
F
.
2
.
3
, 
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.
2
.
4
, 
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.
2
.
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,
SL
.
2
.
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, 
S
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2
.
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)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T54–T55
»	Phonics: Long i: i, ie, i_e, igh, y
»	High-Frequency Words
CLOSE READ
	Identify Theme T56–T57
	Close Read: from Fables
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T57
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T62–T63
»	Read Decodable Text: Rabbit’s Kite
CLOSE READ
	Determine Key Ideas T64–T65
	Close Read: from Fables
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T65
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T68–T69
»	Revisit Decodable Text: Rabbit’s Kite
»	Fluency
COMPARE TEXTS
	Reflect and Share T70–T71
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T71
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Author’s Purpose T58–T59
	Handwriting: Letters r and s T58–T59
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T61
	Strategy and Intervention Activities T60
	Fluency T60
	ELL Targeted Support T60
	Conferring T61
INDEPENDENT/COLLABORATIVE
	Independent Reading T61
	Literacy Activities T61
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T67
	Strategy and Intervention Activities T66
	Fluency T66
	ELL Targeted Support T66
	Conferring T67
INDEPENDENT/COLLABORATIVE
	Independent Reading T67
	Literacy Activities T67
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T73
	Strategy, Intervention, and On-Level/
Advanced Activities T72
	ELL Targeted Support T72
	Conferring T73
INDEPENDENT/COLLABORATIVE
	Independent Reading T73
	Literacy Activities T73
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T73 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T360–T361
»	Poetry: What It Looks Like
»	Share Back
INDEPENDENT WRITING
	Poetry T360–T361
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Poetry T364–T365
»	Generate Ideas
»	Share Back
INDEPENDENT WRITING
	Poetry T364–T365
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Poetry T368
»	Plan Your Poem
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T368–T369 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T350

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Words with Long i T362
	Language and Conventions: Teach Present-Tense Verbs T363


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
Long o T366
	Language and Conventions: Practice 
Present-Tense Verbs T367


	 WRITING BRIDGE	
	Spelling: Words with Long i T370
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T370
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T371
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read a traditional tale and understand its plot.
	I can use language to make connections between reading and writing.
	I can use figurative language and sound devices to write poetry.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com
 (
Materials
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	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T78–T79
»	Phonics: Decode Words with Comparative Endings
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T80–T81
	Listening Comprehension: Read Aloud: “Thunder and Lightning” T84–T85
	Traditional Tale: Legend T84–T85
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	Word Work T92–T93
»	Phonics: Decode and Write Words with Comparative Endings
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T124–T125
»	Phonics: Comparative Endings
»	High-Frequency Words
CLOSE READ
	Discuss Author’s Purpose T126–T127
	Close Read: The Legend of the Lady Slipper
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read folktales and compare versions of the same tale.
	I can use language to make connections between reading and writing traditional tales.
	I can use figurative language and sound devices to write poetry.
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	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T148–T149
»	Phonics: r-Controlled Vowels er, ir, ur
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T150–T151
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 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T162–T163
»	Phonics: Decode and Write Words with r-Controlled Vowels er, ir, ur
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T194–T195
»	Phonics: r-Controlled Vowels er, ir, ur
»	High-Frequency Words
CLOSE READ
	Compare and Contrast Stories T196–T197
	Close Read: Interstellar Cinderella and Cendrillon: An Island Cinderella
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CLOSE READ
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	Reflect and Share T210–T211
»	Talk About It
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	Read Like a Writer, Write for a Reader: 
Word Choice T198–T199
	Handwriting: Letters g and o T198–T199
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TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T201
	Strategy and Intervention Activities T200
	Fluency T200
	ELL Targeted Support T200
	Conferring T201
INDEPENDENT/COLLABORATIVE
	Independent Reading T201
	Literacy Activities T201
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TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T207
	Strategy and Intervention Activities T206
	Fluency T206
	ELL Targeted Support T206
	Conferring T207
INDEPENDENT/COLLABORATIVE
	Independent Reading T207
	Literacy Activities T207
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	Conferring T213
INDEPENDENT/COLLABORATIVE
	Independent Reading T213
	Literacy Activities T213
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	 WRITING WORKSHOP	
MINILESSON
	Poetry T408–T409
»	Apply Alliteration
»	Share Back
INDEPENDENT WRITING
	Poetry T408–T409
	Conferences T398
	 WRITING WORKSHOP	
MINILESSON
	Poetry T412–T413
»	Explore Audio Recording
»	Share Back
INDEPENDENT WRITING
	Poetry T412–T413
	Conferences T398
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	Poetry T416
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»	Share Back
INDEPENDENT WRITING
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn more about traditions by reading about Native American life.
	I can use language to make connections between reading and writing.
	I can use figurative language and sound devices to write poetry.
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	 LESSON 1
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T218–T219
»	Phonics: Diphthongs ou, ow, oi, oy
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T220–T221
	Listening Comprehension: Read Aloud: “Greetings Around the World” T222–T223
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 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T232–T233
»	Decode and Write Words with Diphthongs ou, ow, oi, oy
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	Guided Reading/Leveled Readers T231
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Advanced Activities T230
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	 LESSON 3
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T254–T255
»	Phonics: Diphthongs ou, ow, oi, oy
»	High-Frequency Words
CLOSE READ
	Discuss Author’s Purpose T256–T257
	Close Read: The Abenaki
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FOUNDATIONAL SKILLS
	Word Work T262–T263
»	Read Decodable Text: The Story
CLOSE READ
	Make Connections T264–T265
	Close Read: The Abenaki
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	Word Work T268–T269
»	Revisit Decodable Text: The Story
»	Fluency
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	Reflect and Share T270–T271
»	Write to Sources
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	Spelling: Words with ou, ow, oi, oy T442
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will support planning for the week.
) (
R
I
.
2
.
10
, 
RF
.
2
.
3.b
, 
RF
.
2
.
3.e
,
 SL.2.1, L.2.1, 
L.2.2
)
	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 Min.
INDEPENDENT WRITING	30–40 Min.
WRITING BRIDGE	5–10 Min.
Learning Goals
	I can learn more about traditions by reading a story about traditional foods.
	I can use language to make connections between reading and writing.
	I can use figurative language and sound devices to write poetry.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com
	Writing Workshop Performance-Based Assessment on SavvasRealize.com
	Writing Workshop Assessment

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T278–T279
»	Phonics: Vowel Teams oo, ue, ew, ul
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T280–T281
	Listening Comprehension: Read Aloud: “How to Make Glitter Slime” T282–T283
	Procedural Text T284–T285
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T285
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T292–T293
»	Phonics: Decode and Write Words with Vowel Teams oo, ue, ew, ui
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T293
»	High-Frequency Words
SHARED READ
	Introduce the Text T294–T315
»	Preview Vocabulary
»	Read: My Food, Your Food
	Respond and Analyze T316–T317
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T317
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Oral Language
T286–T287
	Handwriting: Letters y and x T286–T287
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T291
	Strategy, Intervention, and On-Level/
Advanced Activities T290
	ELL Targeted Support T290
	Conferring T291
INDEPENDENT/COLLABORATIVE
	Independent Reading T291
	Literacy Activities T291
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T291 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T318
	Guided Reading/Leveled Readers T321
	Strategy and Intervention Activities 
T318, T320
	Fluency T318, T320
	ELL Targeted Support T318, T320
	Conferring T320
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T319
	Independent Reading T321
	Literacy Activities T321

	
	 WRITING WORKSHOP	
MINILESSON
	Poetry T448–T449
»	Edit for Nouns
»	Share Back
INDEPENDENT WRITING
	Poetry T448–T449
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Poetry T452–T453
»	Edit for Prepositions and Prepositional Phrases
»	Share Back
INDEPENDENT WRITING
	Poetry T452–T453
	Conferences T446

	
	[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png] WRITING BRIDGE	
FLEXIBLE OPTION 
	Spelling: Vowel Teams oo, ue, ew, ui T450
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	Language and Conventions: Spiral Review: Subject-Verb Agreement T451
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	Spelling: Teach Vowel Teams oo, ue, ew, ui T454
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T322–T323
»	Phonics: Vowel Teams oo, ue, ew, ui
»	High-Frequency Words
CLOSE READ
	Understand Text Features T324–T325
	Close Read: My Food, Your Food
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T325
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T330–T331
»	Read Decodable Text: Sue’s New School
CLOSE READ
	Make Inferences T332–T333
	Close Read: My Food, Your Food
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T333
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T336–T337
»	Revisit Decodable Text: Sue’s New School
»	Fluency
COMPARE TEXTS
	Reflect and Share T338–T339
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T339
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Organizing Information T326–T327
	Handwriting: Letters v and z T326–T327
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T329
	Strategy and Intervention Activities T328
	Fluency T328
	ELL Targeted Support T328
	Conferring T329
INDEPENDENT/COLLABORATIVE
	Independent Reading T329
	Literacy Activities T329
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T335
	Strategy and Intervention Activities T334
	Fluency T334
	ELL Targeted Support T334
	Conferring T335
INDEPENDENT/COLLABORATIVE
	Independent Reading T335
	Literacy Activities T335
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T341
	Strategy, Intervention, and On-Level/
Advanced Activities T340
	ELL Targeted Support T340
	Conferring T341
INDEPENDENT/COLLABORATIVE
	Independent Reading T341
	Literacy Activities T341
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T341 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Poetry T456–T457
»	Prepare for Celebration
»	Share Back
INDEPENDENT WRITING
	Poetry T456–T457
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Poetry T460–T461
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	Poetry T460–T461
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Poetry T464–T465
»	Assessment
INDEPENDENT WRITING
	Assessment T464–T465
	Conferences T446

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Vowel Teams oo, ue, ew, ui T458
	Language and Conventions: Teach 
Adverbs T459


	[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png] WRITING BRIDGE	
FLEXIBLE OPTION 
	Spelling: Spiral Review: Diphthongs 
ou, ow, oi, oy T462
	Language and Conventions: Practice 
Adverbs T463


	 WRITING BRIDGE	
	Spelling: Vowel Teams oo, ue, ew, ui T466
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 PROJECT FOCUS 	This week students will
	•	write letters to the principal about traditions they think the school should celebrate or recognize
	•	give opinions on why they think the school should celebrate these traditions

	 LESSON 1	
T474–T475,
T476
T484–T485
RF.2.3, RF.2.4,
W.2.1, SL.2.1.c,
L.2.2.d

	Foundational Skills
•	Phonics: Decode /s/ Spelled c; /j/ Spelled g or dge
•	Spelling
	Compare Across Texts
•	Answer the Essential Question

	Inquire
•	Introduce the Project  
•	Read “A Tradition to Remember”
•	Use Academic Vocabulary

	

	 LESSON 2	
T474–T475,
T476RF.2.3, RF.2.4, W.2.1, W.2.5, W.2.6

T486–T489

	Foundational Skills
•	Phonics: Write /s/ 
Spelled c; /j/ Spelled g or dge
•	Spelling: Spell /s/ Spelled c; /j/ Spelled g, dge

	Explore and Plan
•	Explore Opinion Writing
•	Read: “Blanket Toss!”
	Conduct Research
•	Search Online
•	Apply keyword search

	


	

		 LESSON 3	
T480–T481,
T477
T490–T491
RF.2.3, RF.2.4, W.2.1, W.2.5

	Foundational Skills
•	Phonics: /s/ Spelled c; /j/ Spelled g, dge
•	High-Frequency Words
•	Spelling

	Collaborate and
Discuss
•	Analyze Student Model
•	Read “Birthdays Around the World”
	Refine Research
•	Cite Sources

	




	

		 LESSON 4	
T482–T483,
T477
T490–T493
RF.2.3, W.2.5, SL.2.1.c, SL.2.3, L.2.3.a


	Foundational Skills
•	Phonics: Review Words with /s/ Spelled c; /j/ Spelled g, dge
•	Spelling

	Extend Research
•	Write a Thank You Note
	Collaborate and
Discuss
•	Revise and Edit 


	




	

	 LESSON 5	
T482–T483, 
T477
T494–T495
RF.2.3, SL.2.1,
SL.2.1.b, SL.2.1.c, SL.2.3

	Foundational Skills
•	Phonics: Spiral Review: Compound Words
•	Spelling
	Celebrate and Reflect
•	Present letters
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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	WEEK 3
	

	
	
	Biography
	
	Biography
	
	Realistic Fiction
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]

	
	
	Who Says Women Can’t Be Doctors? The Story of Elizabeth Blackwell
	
	
Building on Nature: The Life of Antoni Gaudí
	
	

The Garden of Happiness
	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Foundational Skills
	Phonics: Closed Syllables VC/V
	RF.2.3
	Phonics: Open Syllables V/CV
	RF.2.3
	Phonics: Suffixes -ly, -ful, 
-er, -less, -or
	RF.2.3; RF.2.3.d

	
	
	High-Frequency Words: sometimes, mountains, young
	RF.2.3.f
	High-Frequency Words: being, talk, song
	RF.2.3; RF.2.3.c
	High-Frequency Words: above, family, music
	RF.2.3.f

	
	
	Decodable Text: Helen’s Story
	RF.2.3
	Decodable Text: Spider’s Web
	RF.2.4.b
	Decodable Text: A Place to Play
	RF.2.3.d

	
	Minilesson 
Bank
	Infographic: People Who Were First
	W.2.8
	Infographic: Creative Places
	SL.2.1
	Infographic: Community Care
	SL.2.4

	
	
	Biography: Who Says Women Can’t Be Doctors? The Story of Elizabeth Blackwell
	RI.2.1; RI.2.3
	Biography: Building on Nature: The Life of Antoni Gaudí
	RI.2.7
	Realistic Fiction: The Garden of Happiness
	RL.2.1; RL.2.7

	
	
	Words with Shades of Meaning
	L.2.5.b
	Domain Specific Vocabulary
	L.2.5
	Word Meanings
	L.2.4.e

	
	
	Identify Text Structure
	RI.2.6
	Use Text Features
	RI.2.7
	Determine Theme
	RL.2.2

	
	
	Ask and Answer Questions
	RI.2.1
	Make Connections
	W.2.8
	Create New Understandings
	RL.2.10

	
	
	Talk About It: Sharing Opinions
	RI.2.1
	Write to Sources: Write an Opinion
	W.2.1
	Talk About It: Make Comments and Build on Ideas
	SL.2.6

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.2.4.c; L.2.5
	Antonyms
	L.2.5
	Context Clues
	L.2.4

	
	
	Handwriting
	Writing Words and Letters 
A and O
	L.1.1.a
	Letters D, C, E, and N
	L.1.1.a
	Letters M and H and Proper Nouns
	L.1.1.a

	
	
	Read Like a Writer/Write for a Reader
	Literal and Figurative Language
	L.2.4
	Descriptive Language
	L.2.3
	Point of View
	L.2.1

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	Personal Narratives
	W.2.3
	Setting
	W.2.3
	Sequence of Events
	W.2.3

	
	
	Personal Narratives: Character
	W.2.3
	Explore the Main Character: You
	W.2.3
	Explore Conclusion
	W.2.3

	
	
	Personal Narratives: Setting and Plot
	W.2.3
	Apply the Main Character: You
	W.2.3
	Apply Conclusion
	W.2.3

	
	
	Generate Ideas
	W.2.3
	Explore Problem and Resolution
	W.2.3
	Explore Details
	W.2.3

	
	
	Plan A Personal Narrative
	SL.2.4; W.2.3
	Apply Problem and Resolution
	W.2.3
	Apply Details
	SL.2.5

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Words with Closed Syllables VC/V
	L.2.2
	Spell Words with Open Syllables V/CV
	RF.2.3
	Spell Words with Suffixes 
-ly, -ful, -er, -less, -or
	L.2.2

	
	
	Language & Conventions
	Adjectives and Adverbs
	L.2.1.e; L.2.6
	Comparative and Superlative Adjectives
	L.2.1.e
	Commas in Dates and Letters
	L.2.2; L.2.2.b



 (
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 (
Essential Question
)
Why is it important to connect with other people?
	WEEK 4
	
	WEEK 5
	

	Biography
	
	Persuasive Text
	

	One Plastic Bag: Isatou Ceesay and the Recycling Women of the Gambia
	
	

Kids Can Be Big Helpers
	

	
	CCSS
	
	CCSS

	Phonics: Prefixes un-, re-, pre-, dis-
	RF.2.3.d; L.2.4.b
	Phonics: Syllable Pattern VCCV
	RF.2.3

	High-Frequency Words: color, questions, area
	L.2.4.b
	High-Frequency Words: horse, problem, complete
	RF.2.3.f

	Decodable Text: Cleaning the Beach
	RF.2.4; RF.2.4.b
	Decodable Text: Kent’s Idea
	RF.2.3

	Infographic: Old Stuff, New Uses
	W.2.8
	Infographic: Look What We Can Do!
	SL.2.1

	Biography: One Plastic Bag: Isatou Ceesay and the Recycling Women of the Gambia
	RI.2.3
	Persuasive Text: Kids Can Be Big Helpers
	RI.2.6

	Use Sources to Determine Word Meanings
	L.2.6
	Use a Dictionary to Determine Word Meanings
	L.2.4.e

	Identify Text Structure: Chronological
	RI.2.3
	Understand Persuasive Text
	RI.2.8

	Make and Confirm Predictions
	RI.2.10
	Monitor Comprehension
	RF.2.4.c

	Write to Sources: Retell a Text
	L.2.1
	Talk About It: Take Turns
	SL.2.1.a

	Word Parts: Prefix un-
	L.2.4.b; L.2.4.c
	Oral Language
	L.2.6

	Letters K, U, Y, and Z
	L.1.1.a
	Letters V, W, X, and I
	L.1.1.a

	Idioms
	L.2.6
	Word Choice
	RI.2.8

	Writer’s Craft
	Publish, Celebrate, and Assess

	Capitalization and Commas
	L.2.3
	Edit for Adjectives and Adverbs
	W.2.5

	Explore Pronouns
	L.2.3
	Edit for Spelling
	L.2.2

	Apply Pronouns
	L.2.3
	Prepare for Celebration
	W.2.5

	Explore Compound Subjects and Predicates
	L.2.3
	Celebration
	SL.2.1

	Apply Compound Subjects and Predicates
	L.2.3
	Assessment
	W.2.3

	Spell Words with Prefixes un-, re-, pre-, dis-
	RF.2.3.d
	Spell Words with Syllable Pattern VCCV
	RF.2.3

	Pronouns
	L.2.1
	Reflexive Pronouns
	L.2.1.b
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Time Capsule
	

	
	CCSS

	Foundational Skills

	Phonics: Consonant Patterns kn, wr, gn, mb, lf
	RF.2.3

	High-Frequency Words: since, usually, friends
	RF.2.3.f

	Spelling: Spell Words with kn, wr, gn, mb, lf
	RF.2.3.f

	Compare Across Texts: “Making a Difference”
	RI.2.9

	Inquire: Time Capsule
	W.2.7

	Leveled Research Articles
	RF.2.4.a

	Academic Words
	L.2.6

	Explore and Plan: Introduce Informational Writing
	W.2.2

	Conduct Research: Use a Web Site
	RI.2.5; W.2.6

	Collaborate and Discuss: Analyze Student Model
	W.2.7

	Primary and Secondary Sources
	W.2.7

	Extend Research: Write a Letter
	W.2.5

	Revise and Edit; Peer Review
	W.2.5

	Celebrate and Reflect
	SL.2.1.b




 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I know about narrative nonfiction and understand its elements.
	I can use language to make connections between reading and writing narrative nonfiction.
	I can use elements of narrative nonfiction to write a personal narrative.
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	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T18–T19
»	Phonics: Closed Syllables VC/V
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T20–T21
	Listening Comprehension: Read Aloud: “Jackie Robinson: Opening the Doors” T22–T23
	Biography T24–T25
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T25
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T32–T33
»	Phonics: Closed Syllables VC/V
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T33
»	High-Frequency Words
GENRE & THEME
	Introduce the Text T34–T55
»	Preview Vocabulary
»	Read: Who Says Women Can’t Be Doctors? The Story of Elizabeth Blackwell
	Respond and Analyze T56–T57
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T57
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T26–T27
	Handwriting: Write Words T26–T27
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T58
	Guided Reading/Leveled Readers T61
	Strategy and Intervention Activities T58, T60
	Fluency T58, T60
	ELL Targeted Support T58, T60
	Conferring T65
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T59
	Independent Reading T61
	Literacy Activities T61

	
	 WRITING WORKSHOP	
GENRE IMMERSION LESSON
	Personal Narrative T362–T363
»	Personal Narratives
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T362–T363
	Conferences T360
	 WRITING WORKSHOP	
GENRE IMMERSION LESSON
	Personal Narrative T366–T367
»	Personal Narratives: Character
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T366–T367
	Conferences T360

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Closed Syllables VC/V T364
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	Language and Conventions: Spiral Review: Adverbs T365
	 WRITING BRIDGE	
	Spelling: Teach Words with Closed Syllables VC/V T368
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	Language and Conventions: Oral Language: Adjectives and Adverbs T369
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T62–T63
»	Phonics: Closed Syllables VC/V
»	High-Frequency Words
CLOSE READ
	Identify Text Structure T64–T65
	Close Read: Who Says Women Can’t Be Doctors? The Story of Elizabeth Blackwell
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T65
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T70–T71
»	Read Decodable Text: Helen’s Story
»	Fluency
CLOSE READ
	Ask and Answer Questions T72–T73
	Close Read: Who Says Women Can’t Be Doctors? The Story of Elizabeth Blackwell
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T73
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T76–T77
»	Revisit Decodable Text: Helen’s Story
»	Fluency
COMPARE TEXTS
	Reflect and Share T78–T79
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T79
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Literal and Figurative Language T66–T67
	Handwriting: Letters A and O T66–T67
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T69
	Strategy and Intervention Activities T68
	Fluency T68
	ELL Targeted Support T68
	Conferring T69
INDEPENDENT/COLLABORATIVE
	Independent Reading T69
	Literacy Activities T69
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T75
	Strategy and Intervention Activities T74
	Fluency T74
	ELL Targeted Support T74
	Conferring T75
INDEPENDENT/COLLABORATIVE
	Independent Reading T75
	Literacy Activities T75
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T81
	Strategy, Intervention, and On-Level/
Advanced Activities T80
	ELL Targeted Support T80
	Conferring T81
INDEPENDENT/COLLABORATIVE
	Independent Reading T81
	Literacy Activities T81
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T81 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
GENRE IMMERSION LESSON
	Personal Narrative T370–T371
»	Personal Narratives: Setting and Plot
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T370–T371
	Conferences T360
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T374–T375
»	Generate Ideas
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T374–T375
	Conferences T360
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T378
»	Plan a Personal Narrative
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T378–T379 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T360

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Words with Closed Syllables VC/V T372
	Language and Conventions: Teach Adjectives and Adverbs T373

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
Vowel Teams oo, ue, ew, and ui T376
	Language and Conventions: Practice 
Adjectives and Adverbs T377

	 WRITING BRIDGE	
	Spelling: Words with closed Syllables 
VC/V T380
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T380
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T381
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read a biography and use print and graphic features.
	I can use language to make connections between reading and writing narrative nonfiction.
	I can use elements of narrative nonfiction to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T86–T87
»	Phonics: Decode Words with Open Syllables V/CV
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T88–T89
	Listening Comprehension: Read Aloud: “The Learning Tower of Pisa” T90–T91
	Biography T92–T93
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T93
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T100–T101
»	Phonics: Decode and Write Words with Open Syllables V/CV
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T101
»	High-Frequency Words
SHARED READ
	Introduce the Text T102–T123
»	Preview Vocabulary
»	Read: Building on Nature: The Life of Antoni Gaudí
	Respond and Analyze T124–T125
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T125
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Antonyms 
T94–T95
	Handwriting: Letters D and C T94–T95
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T99
	Strategy, Intervention, and On-Level/
Advanced Activities T98
	ELL Targeted Support T98
	Conferring T99
INDEPENDENT/COLLABORATIVE
	Independent Reading T99
	Literacy Activities T99
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T99 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T126
	Guided Reading/Leveled Readers T129
	Strategy and Intervention Activities T126, T128
	Fluency T126, T128
	ELL Targeted Support T126, T128
	Conferring T129
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T127
	Independent Reading T129
	Literacy Activities T129

	
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T386–T387
»	Compose Setting
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T386–T387
	Conferences T384
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T390–T391
»	Explore the Main Character: You
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T390–T391
	Conferences T384

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Open Syllables 
V/CV T388
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T388
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Adjectives and Adverbs T389
	 WRITING BRIDGE	
	Spelling: Teach Words with Open Syllables V/CV T392
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Comparative and Superlative Adjectives T393


 (
UNIT 
4
 WEEK 
2
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
R
I
.
2
.
7
, R
F
.
2
.
3
, 
W
.
2.3
,
SL
.
2
.
1
, L.
2
.
1.e
) (
R
F
.
2
.
3
, RF.
2
.
4
, 
W
.
2
.
3
,
W
.
2
.
8
, L.
2
.
1.e
) (
R
F
.
2
.
3
, 
RF
.
2
.
4
, 
W
.
2
.
3
,
SL
.
2
.
1
, L.
2
.
6
)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T130–T131
»	Phonics: Open Syllables V/CV
»	High-Frequency Words
CLOSE READ
	Use Text Features T132–T133
	Close Read: Building on Nature: The Life of Antoni Gaudí
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T133
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T138–T139
»	Read Decodable Text: Spider’s Web
»	Fluency
CLOSE READ
	Make Connections T140–T141
	Close Read: Building on Nature: The Life of Antoni Gaudi
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T141
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T144–T145
»	Read Decodable Text: Spider’s Web
»	Fluency
COMPARE TEXTS
	Reflect and Share T146–T147
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T147
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Descriptive Language T134–T135
	Handwriting: Letters E and N T134–T135
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T137
	Strategy and Intervention Activities T136
	Fluency T136
	ELL Targeted Support T136
	Conferring T137
INDEPENDENT/COLLABORATIVE
	Independent Reading T137
	Literacy Activities T137
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T141
	Strategy and Intervention Activities T142
	Fluency T142
	ELL Targeted Support T142
	Conferring T143
INDEPENDENT/COLLABORATIVE
	Independent Reading T143
	Literacy Activities T143
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T149
	Strategy, Intervention, and On-Level/
Advanced Activities T148
	ELL Targeted Support T148
	Conferring T149
INDEPENDENT/COLLABORATIVE
	Independent Reading T149
	Literacy Activities T149
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T149 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T394–T395
»	Apply the Main Character: You
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T394–T395
	Conferences T384
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T398–T399
»	Explore Problem and Resolution
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T398–T399
	Conferences T384
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T402
»	Apply Problem and Resolution
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T402–T403 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T384
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FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Words with Open Syllables V/CV T396
	Language and Conventions: Teach Comparative and Superlative Adjectives T397
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FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
Closed Syllables VC/V T400
	Language and Conventions: Practice 
Comparative and Superlative Adjectives T401


	 WRITING BRIDGE	
	Spelling: Words with Open Syllables V/CV
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Turn the page for a list of materials that 
will support planning for the week.
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 Min.
INDEPENDENT WRITING	30–40 Min.
WRITING BRIDGE	5–10 Min.
Learning Goals
	I can read informational text and understand text structure.
	I can use language to make connections between reading and writing.
	I can use elements of informational text 
to write.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T154–T155
»	Phonics: Decode Words with Suffixes 
-ly, -ful, -er, -less, -or
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T156–T157
	Listening Comprehension: Read Aloud: “Making a Difference in Your Community” T158–T159
	Realistic Fiction T160–T161
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T161
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T168–T169
»	Phonics: Decode and Write Words with Suffixes -ly, -ful, -er, -less, -or
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T169
»	High-Frequency Words
SHARED READ
	Introduce the Text T170–T193
»	Preview Vocabulary
»	Read: The Garden of Happiness
	Respond and Analyze T194–T195
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T195
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues
T162–T163
	Handwriting: Letters M and H T162–T163
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T167
	Strategy, Intervention, and On-Level/
Advanced Activities T166
	ELL Targeted Support T166
	Conferring T167
INDEPENDENT/COLLABORATIVE
	Independent Reading T167
	Literacy Activities T167
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T167 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T196
	Guided Reading/Leveled Readers T199
	Strategy and Intervention Activities T196, T198
	Fluency T196, T198
	ELL Targeted Support T196, T198
	Conferring T199
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T197
	Independent Reading T199
	Literacy Activities T199

	
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T410–T411
»	Sequence of Events
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T410–T411
	Conferences T408
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T414–T415
»	Explore Conclusion
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T414–T415
	Conferences T408

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Words with Suffixes -ly, -ful, 
-er, -less, -or T412
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T412
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	Language and Conventions: Spiral Review: Comparative and Superlative Adjectives T413
	 WRITING BRIDGE	
	Spelling: Teach Suffixes -ly, -ful, -er, 
-less, -or T416
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Commas in Dates and 
Letters T417
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T200–T201
»	Phonics: Suffixes -ly, -ful, -er, -less, -or
»	High-Frequency Words
CLOSE READ
	Determine Theme T202–T203
	Close Read: The Garden of Happiness
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T203
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T208–T209
»	Read Decodable Text: A Place to Play
»	Fluency
CLOSE READ
	Create New Understandings T210–T211
	Close Read: The Garden of Happiness
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T211
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T214–T215
»	Revisit Decodable Text: A Place to Play
»	Fluency
COMPARE TEXTS
	Reflect and Share T216–T217
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T217
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Point of View T204–T205
	Handwriting: Write Proper Nouns 
T204–T205
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T207
	Strategy and Intervention Activities T206
	Fluency T206
	ELL Targeted Support T206
	Conferring T207
INDEPENDENT/COLLABORATIVE
	Independent Reading T207
	Literacy Activities T207
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T213
	Strategy and Intervention Activities T212
	Fluency T212
	ELL Targeted Support T212
	Conferring T213
INDEPENDENT/COLLABORATIVE
	Independent Reading T213
	Literacy Activities T213
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T219
	Strategy, Intervention, and On-Level/
Advanced Activities T218
	ELL Targeted Support T218
	Conferring T219
INDEPENDENT/COLLABORATIVE
	Independent Reading T219
	Literacy Activities T219
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T219 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T418–T419
»	Apply Conclusion
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T418–T419
	Conferences T408
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T422–T423
»	Explore Details
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T422–T423
	Conferences T408
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T426
»	Apply Details
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T426–T427 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T408

	 WRITING BRIDGE	
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	Spelling: Review and More Practice: 
Suffixes -ly, -ful, -er, -less, -or T420
	Language and Conventions: Teach 
commas in Dates and Letters T421


	 WRITING BRIDGE	
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	Spelling: Spiral Review: Open Syllables V/CV T424
	Language and Conventions: Practice 
Commas in Dates and Letters T425


	 WRITING BRIDGE	
	Spelling: Suffixes -ly, -ful, -er, -less, -or T428
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[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T429







 (
Materials
Turn the page for a list of materials that 
will support planning for the week.
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 Min.
INDEPENDENT WRITING	30–40 Min.
WRITING BRIDGE	5–10 Min.
Learning Goals
	I can read a biography and understand its text structure.
	I can use language to make connections between reading and writing narrative nonfiction.
	I can use elements of narrative nonfiction to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com

	 LESSON 1
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T224–T225
»	Phonics: Decode Words with Prefixes un-, re-, pre-, dis-
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T226–T227
	Listening Comprehension: Read Aloud: “Shoes and Hands Across the World” T228–T229
	Biography T230–T231
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]Quick Check T231
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) LESSON 2
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T238–T239
»	Phonics: Decode and Write Words with Prefixes un-, re-, pre-, dis-
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]Quick Check T239
»	High-Frequency Words
SHARED READ
	Introduce the Text T240–T263
»	Preview Vocabulary
»	Read: One Plastic Bag
	Respond and Analyze T264–T265
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]Quick Check T265
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Word Parts:
T232–T233
	Handwriting: Letters K and U T232–T233
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T237
	Strategy, Intervention, and On-Level/
Advanced Activities T236
	ELL Targeted Support T236
	Conferring T237
INDEPENDENT/COLLABORATIVE
	Independent Reading T237
	Literacy Activities T237
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T237 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T266
	Guided Reading/Leveled Readers T269
	Strategy and Intervention Activities T266, T268
	Fluency T266, T268
	ELL Targeted Support T266, T268
	Conferring T269
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T267
	Independent Reading T269
	Literacy Activities T269

	
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T434–T435
»	Capitalization and Commas
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T434–T435
	Conferences T432
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T438–T439
»	Explore Pronouns
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T438–T439
	Conferences T432

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Spelling: Words with Prefixes un-, re-, 
pre-, dis- T436
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]Assess Prior Knowledge T436
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Spiral Review: Commas Dates and Letters T437
	 WRITING BRIDGE	
	Spelling: Teach Words with Prefixes un-, re-, pre-, dis- T440
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Oral Language: Pronouns T441
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	 LESSON 3
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T270–T271
»	Phonics: Prefixes un-, re-, pre-, dis-
»	High-Frequency Words
CLOSE READ
	Identify Text Structure T272–T273
	Close Read: One Plastic Bag
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]Quick Check T273
	 LESSON 4
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T278–T279
»	Read Decodable Text: Cleaning the Beach
»	Fluency
CLOSE READ
	Make and Confirm Predications T280–T281
	Close Read: One Plastic Bag
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]Quick Check T281
	 LESSON 5
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T284–T285
»	Revisit Decodable Text: Cleaning the Beach
»	Fluency
COMPARE TEXTS
	Reflect and Share T286–T287
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]Quick Check T287
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Idioms T274–T275
	Handwriting: Letters Y and Z T274–T275
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T277
	Strategy and Intervention Activities T276
	Fluency T276
	ELL Targeted Support T276
	Conferring T277
INDEPENDENT/COLLABORATIVE
	Independent Reading T277
	Literacy Activities T277
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T283
	Strategy and Intervention Activities T282
	Fluency T282
	ELL Targeted Support T282
	Conferring T283
INDEPENDENT/COLLABORATIVE
	Independent Reading T283
	Literacy Activities T283
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T289
	Strategy, Intervention, and On-Level/
Advanced Activities T288
	ELL Targeted Support T288
	Conferring T289
INDEPENDENT/COLLABORATIVE
	Independent Reading T279
	Literacy Activities T279
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T289 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T442–T443
»	Apply Pronouns
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T442–T443
	Conferences T432
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T446–T447
»	Explore Compound Subjects and Predicates
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T446–T447
	Conferences T432
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T450
»	Apply Compound Subjects and Predicates
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T450–T451 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T432

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Spelling: Review and More Practice: 
Words with Prefixes un-, re-, pre-, 
dis- T444
	Language and Conventions: Teach Pronouns T445


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Spelling: Spiral Review: Words with 
Suffixes -ly, -ful, -er, -less, -or T448
	Language and Conventions: Practice 
Pronouns T449


	 WRITING BRIDGE	
	Spelling: Words with Prefixes un-, re-, pre-, dis- T452
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]Assess Understanding T452
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION
	Language and Conventions: Standards Practice T453
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can learn about making a difference by reading a persuasive text.
	I can develop knowledge about language to make connections between reading and writing.
	I can use elements of narrative nonfiction to write a personal narrative.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com
	Writing Workshop Performance-Based Assessment on SavvasRealize.com
	Writing Workshop Assessment

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T294–T295
»	Phonics: Decode Words with Syllable Pattern VCCV
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T296–T297
	Listening Comprehension: Read Aloud: “Volunteering Helps Everyone” 
T298–T299
	Persuasive Text T300–T301
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T301
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T308–T309
»	Phonics: Decode and Write Words with Syllable Pattern VCCV
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T309
»	High-Frequency Words
SHARED READ
	Introduce the Text T310–T325
»	Preview Vocabulary
»	Read: Kids Can Be Big Helpers
	Respond and Analyze T326–T327
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T327
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Oral Language
T302–T303
	Handwriting: Letters V and W T302–T303
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T307
	Strategy, Intervention, and On-Level/
Advanced Activities T306
	ELL Targeted Support T306
	Conferring T307
INDEPENDENT/COLLABORATIVE
	Independent Reading T307
	Literacy Activities T307
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T307 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T328
	Guided Reading/Leveled Readers T331
	Strategy and Intervention Activities 
T328, T330
	Fluency T328, T330
	ELL Targeted Support T328, T330
	Conferring T331
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T329
	Independent Reading T331
	Literacy Activities T331

	
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T458–T459
»	Edit for Adjectives and Adverbs
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T458–T459
	Conferences T456
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T462–T463
»	Edit for Spelling
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T462–T463
	Conferences T456

	
	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Syllable Pattern VCCV T460
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Prior Knowledge T460
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Pronouns T461
	 WRITING BRIDGE	
	Spelling: Teach Syllable Pattern VCCV T464
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Oral Language: Reflexive Pronouns T465
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T332–T333
»	Phonics: Syllable Pattern VCCV
»	High-Frequency Words
CLOSE READ
	Understand Persuasive Pattern T334–T335
	Close Read: Kids Can Be Big Helpers
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T335
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T340–T341
»	Read Decodable Text: Kent’s Idea
»	Fluency
CLOSE READ
	Monitor Comprehension T342–T343
	Close Read: Kids Can Be Big Helpers
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T343
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T346–T347
»	Revisit Decodable Text: Kent’s Idea
»	Fluency
COMPARE TEXTS
	Reflect and Share T348–T349
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T349
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Word Choice T336–T337
	Handwriting: Letters X and I T336–T337
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T339
	Strategy and Intervention Activities T338
	Fluency T338
	ELL Targeted Support T338
	Conferring T339
INDEPENDENT/COLLABORATIVE
	Independent Reading T339
	Literacy Activities T339
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T345
	Strategy and Intervention Activities T344
	Fluency T344
	ELL Targeted Support T344
	Conferring T345
INDEPENDENT/COLLABORATIVE
	Independent Reading T345
	Literacy Activities T345
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T351
	Strategy, Intervention, and On-Level/
Advanced Activities T350
	ELL Targeted Support T350
	Conferring T351
INDEPENDENT/COLLABORATIVE
	Independent Reading T351
	Literacy Activities T351
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T351 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T466–T467
»	Prepare for Celebration
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T466–T467
	Conferences T456
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T470–T471
»	Celebration
»	Share Back
INDEPENDENT WRITING
	Personal Narrative T470–T471
	Conferences T456
	 WRITING WORKSHOP	
MINILESSON
	Personal Narrative T474
»	Assessment
INDEPENDENT WRITING
	Assessment T474–T475
	Conferences T456

	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Review and More Practice: 
Syllable Pattern VCCV T468
	Language and Conventions: Teach Reflexive Pronouns T469


	 WRITING BRIDGE	
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Spelling: Spiral Review: Words with 
Prefixes un-, re-, pre-, dis- T472
	Language and Conventions: Practice 
Reflexive Pronouns T473


	 WRITING BRIDGE	
	Spelling: Syllable Pattern VCCV T476
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Assess Understanding T476
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:arrow.png]FLEXIBLE OPTION 
	Language and Conventions: Standards Practice T477







 PROJECT FOCUS 	This week students will
	•	collect items from their lives to share and use to create a group time capsule
	•	write letters to themselves about the time capsule project

	 LESSON 1	
T484–T485,
T486
T494–T495
RF.2.3, W.2.2,
W.2.7, L.2.2

	Foundational Skills
•	Phonics: Decode Words with Consonant Patterns kn, wr, gn, mb, lf
•	Spelling
	Compare Across Texts
•	Answer the Essential Question

	Inquire
•	Introduce the Project  
•	Read “Time Capsules”
•	Use Academic Vocabulary

	

	 LESSON 2	
T484–T485,
T486
T496–T499
RF.2.3, W.2.2, L.2.2

	Foundational Skills
•	Phonics: Decode and Spell Words with Consonant Patterns kn, wr, gn, mb, lf
•	Spelling: Spell Words with kn, wr, gn, mb, lf

	Explore and Plan
•	Introduce informational Writing
•	Read: “Let’s Connect!”
	Conduct Research
•	Use a Web Site


	


	

		LESSON 3	
T490–T491,
T487
T500–T501
RF.2.3, W.2.2, L.2.2

	Foundational Skills
•	Phonics: Consonant Patterns kn, wr, gn, mb, lf
•	High-Frequency Words
•	Spelling

	Collaborate and
Discuss
•	Analyze Student Model
•	Read “Connecting for a Cause”
	Refine Research
•	Primary and Secondary Sources

	




	

		LESSON 4	
T492–T493,
T487
T502–T503
RF.2.3, W.2.2,
W.2.5, L.2.2

	Foundational Skills
•	Phonics: Review Words with Consonant Patterns kn, wr, gn, mb, lf
•	High-Frequency Words
•	Spelling

	Extend Research
•	Write a Letter
•	Revise and Edit
•	Peer Review
	Collaborate and
Discuss
•	Revise and Edit Your List


	




	

	 LESSON 5	
T492–T493, 
T487
T502–T503
RF.2.3, W.2.2,
W.2.5, L.2.2

	Foundational Skills
•	Phonics: Spiral Review: Words with Syllable Pattern VCCV
•	Spelling
	Celebrate and Reflect
•	Present time capsule items
•	Reflect on your project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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UNIT THEME
Our Incredible Earth
	
	
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_1.png]WEEK 1
	
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_2.png]WEEK 2
	
	WEEK 3
	

	
	
	Informational Text
	
	Informational Text
	
	Drama
	[image: Mac:Users:santosh:Desktop:SA00835:Images: GK:GKU1_3.png]

	
	
	Introducing Landforms

	
	How Water Shapes the Earth/How Earthquakes 
Shape the Earth
	Where Do They Go in  Rain or Snow?

	

	
	
	
	CCSS
	
	CCSS
	
	CCSS

	READING WORKSHOP
	Foundational Skills
	Phonics: Homographs
	L.2.4
	Phonics: Double Consonants
	RF.2.3.f
	Phonics: Vowel Patterns aw, au, augh, al
	RF.2.3.e

	
	
	High-Frequency Words: heard, door, sure
	RF.2.3.f
	High-Frequency Words: become, across, during
	RF.2.3.f
	High-Frequency Words: hours, products, happened
	RF.2.3.f

	
	
	Decodable Text: The Best Place
	RF.2.4
	Decodable Text: The Changing River
	RF.2.3.f
	Decodable Text: A Small Tree in a Big Wind
	RF.2.3.f

	
	Minilesson 
Bank
	Infographic: Earth’s Features
	RI.2.7; SL.2.2
	Infographic: The Grand Canyon
	L.2.6
	Infographic: Lightning!
	SL.2.5

	
	
	Informational Text: Introducing Landforms
	RI.2.3; RI.2.7
	Informational Text: How Water Shapes the Earth/ How Earthquakes Shape the Earth
	RI.2.9
	Drama: Where Do They Go in Rain or Snow?
	RL.2.7

	
	
	Words That Tell About Landforms
	L.2.5.a
	Words That Tell About Natural Disasters
	L.2.4.a
	Words That Tell About How Animals Take Shelter from Rain
	L.2.4.a

	
	
	Describe Connections
	RI.2.3
	Compare and Contrast Texts
	RI.2.9
	Identify Elements of Drama
	RL.2.7

	
	
	Monitor Comprehension
	RF.2.4.c
	Create New Understandings
	RI.2.3
	Confirm or Adjust Predictions
	RL.2.10

	
	
	Talk About It: Respond to Informational Text
	SL.2.1.c
	Write to Sources: Respond to Informational Text
	W.2.2
	Talk About It: Respond to Literature
	SL.2.4

	
	READING-WRITING 
WORKSHOP BRIDGE
	Academic Vocabulary
	Related Words
	L.2.5
	Synonyms
	L.2.5.b
	Context Clues
	L.2.4.a

	
	
	Handwriting
	Write Proper Nouns and Letters J and Q
	L.1.1.a
	Letters T, F, G, and S
	L.1.1.a
	Letters L, P, R, and B
	L.1.1.a

	
	
	Read Like a Writer/Write for a Reader
	How Graphic Features Support Purpose
	RI.2.7
	Cause and Effect
	RI.2.3
	Word Choice
	RL.2.7

	WRITING WORKSHOP
	Weekly Focus
	Introduce and Immerse
	Develop Elements
	Develop Structure

	
	Minilesson Bank
	How-To Books
	W.2.2
	How to Write a Command
	W.2.2
	Organize with Structure
	W.2.2

	
	
	How-To Books: Instructions
	W.2.2
	Explore Writing Precise Instructions
	W.2.2
	Explore Writing in Steps
	W.2.2

	
	
	How-To Books: Graphics
	W.2.2
	Apply Writing Precise Instructions
	W.2.2
	Apply Writing in Steps
	W.2.2

	
	
	Generate Ideas
	W.2.2
	Explore Graphics
	RI.2.7
	Explore Introduction and Conclusion
	W.2.2

	
	
	Plan Your How-To Book
	SL.2.1
	Apply Graphics
	RI.2.7
	Apply Introduction and Conclusion
	W.2.2

	
	READING-WRITING 
WORKSHOP BRIDGE
	Spelling
	Spell Words That Are Homographs
	L.2.4
	Spell Words with Double Consonants
	L.2.2.d
	Spell Words with Vowel Patterns aw, au, augh, al
	RF.2.3.e

	
	
	Language & Conventions
	Prepositions and Prepositional Phrases
	L.2.1.f
	Contractions
	L.2.2.c
	Commas in Sentences
	L.2.2



 (
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 (
Essential Question
)
How does Earth change?
	WEEK 4
	
	WEEK 5
	

	Poetry
	
	Informational Text
	

	Volcano Wakes Up!


	
	Rocks!


	

	
	CCSS
	
	CCSS

	Phonics: Prefixes un-, re-, pre-, dis-
	RF.2.3
	Phonics: Syllable Pattern VCCV
	RF.2.3

	High-Frequency Words: color, questions, area
	RF.2.3.f
	High-Frequency Words: horse, problem, complete
	RF.2.3.f

	Decodable Text: Cleaning the Beach
	RF.2.4.a
	Decodable Text: Kent’s Idea
	L.2.3

	Infographic/Diagram: Earth Erupts
	RI.2.1
	Infographic: Famous Rocks
	RI.2.1

	Poetry: Volcano Wakes Up!
	RL.2.4; L.2.5.a
	Informational Text: Rocks!
	RI.2.2

	Words That Tell About Volcanoes
	L.2.4
	Words That Tell About the Earth’s Surface
	L.2.4.a

	Explain Patterns and Structures
	RL.2.4
	Identify Main Idea
	RI.2.2

	Make Connections
	L.2.5.a
	Make Inferences
	RI.2.2

	Write to Sources: Respond to Literature
	RL.2.4
	Talk About It
	RI.2.2

	Word Parts
	RF.2.3.d
	Oral Language
	L.2.5

	Write Proper Nouns and Practice Cursive Writing
	L.1.1.a
	Practice Cursive Writing
	L.1.1.a

	Patterns and Structures of Poetry
	RL.2.4
	Descriptive Details
	RI.2.6

	Writer’s Craft
	Publish, Celebrate, and Assess

	Edit for Adverbs
	L.2.1.e
	Edit for Pronouns
	L.2.1.c

	Explore Adding or Deleting Words
	L.2.1.f
	Edit for Capitalization
	L.2.2

	Apply Adding or Deleting Words
	W.2.5
	Prepare for Celebration
	W.2.2

	Explore Rearranging Words
	L.2.1.f
	Publish and Celebrate
	W.2.6

	Apply Rearranging Words
	L.2.1.f
	Assessment
	W.2.2

	Spell Words with Syllable Pattern VCCCV
	RF.2.3.e
	Spell Abbreviations
	L.2.2.a

	Compound Subjects and Predicates
	L.2.1.f
	Spell Words Correctly
	L.2.2
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	This Is So Exciting!


	

	
	CCSS

	Foundational Skills

	Phonics: Final Stable Syllables -le, -tion, -sion
	RF.2.3

	High-Frequency Words: toward, against, numeral
	RF.2.3.f

	Spelling: Spell Words with Final Stable Syllables -le, 
-tion, -sion
	L.2.2

	Compare Across Texts: “Our Incredible Earth”
	RI.2.9

	Inquire: TV Infomercial
	W.2.1; L.2.3

	Leveled Research Articles
	RF.2.4.a

	Academic Vocabulary
	L.2.3

	Explore and Plan: Introduce Argumentative Writing
	RI.2.2; W.2.1

	Conduct Research: Use Media to Research
	W.2.7

	Collaborate and Discuss: Analyze Student Model
	W.2.1; W.2.8

	Cite Your Sources
	W.2.7

	Extend Research: Make a Video or Record Infomercial
	W.2.5; W.2.6

	Revise and Edit
	W.2.5

	Celebrate and Reflect
	SL.2.1.a; SL.2.1.c
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Turn the page for a list of materials that 
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read informational text and learn facts about a topic.
	I can use language to make connections between reading and writing informational texts.
	I can use elements of informational text to write a personal text.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T18–T19
»	Phonics: Decode Homographs
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T20–T21
	Listening Comprehension: Read Aloud: “The Grand Canyon” T22–T23
	Informational Text T24–T25
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T25
	 LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T32–T33
»	Phonics: Decode and Write Homographs
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T33
»	High-Frequency Words
SHARED READ
	Introduce the Text T34–T53
»	Preview Vocabulary
»	Read: Introducing Landforms
	Respond and Analyze T54–T55
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T55
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Related Words T26–T27
	Handwriting: Write Proper Nouns T26–T27
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T31
	Strategy, Intervention, and On-Level/
Advanced Activities T30
	ELL Targeted Support T30
	Conferring T31
INDEPENDENT/COLLABORATIVE
	Independent Reading T31
	Literacy Activities T31
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T31 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T56
	Guided Reading/Leveled Readers T59
	Strategy and Intervention Activities 
T56, T58
	Fluency T56, T58
	ELL Targeted Support T56, T58
	Conferring T59
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T57
	Independent Reading T59
	Literacy Activities T59

	
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T352–T353
»	How-To Books: Genre Immersion
»	Share Back
INDEPENDENT WRITING
	How-To Book T352–T353
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T356–T357
»	How-To Books: Instructions: Genre Immersion
»	Share Back
INDEPENDENT WRITING
	How-To Book T356–T357
	Conferences T350

	
	 WRITING BRIDGE	
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	Spelling: Homographs T354
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FLEXIBLE OPTION 
	Language and Conventions: Spiral Review: Reflexive Pronouns T355
	 WRITING BRIDGE	
	Spelling: Teach Homographs T358
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	Language and Conventions: Oral Language: Prepositions and Prepositional Phrases T359


 (
UNIT 
5
 WEEK 1
SUGGESTED WEEKLY PLAN
)

Copyright © Savvas Learning Company LLC. All Rights Reserved.
Savvas is not responsible for any modifications made by end users to the content posted in its original format.
 (
R
I
.
2
.3, R
I
.
2
.
10
, 
Sl
.
2.1
,
W.
2
.2, L.
2
.
4
) (
R
I
.
2
.
3
, RF.
2
.
3
, 
SL
.
2
.
1
,
W
.
2
.
2
, L.
2
.
6
) (
R
I
.
2
.
3
, 
SL
.
2
.
1
.
c
, 
SL
.
2
.
3
,
W
.
2
.
2
, L.
2
.1
)
	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T60–T61
»	Phonics: Review Homographs
»	High-Frequency Words
CLOSE READ
	Describe Connections T62–T63
	Close Read: Introducing Landforms
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T63
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T68–T69
»	Read Decodable Text: The Best Place
CLOSE READ
	Monitor Comprehension T70–T71
	Close Read: Introducing Landforms
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T71
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T74–T75
»	Revisit Decodable Text: The Best Place
»	Fluency
COMPARE TEXTS
	Reflect and Share T76–T77
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T77
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
How Graphic Features Support Purpose T64–T65
	Handwriting: Letters J and Q T64–T65
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T67
	Strategy and Intervention Activities T66
	Fluency T66
	ELL Targeted Support T66
	Conferring T67
INDEPENDENT/COLLABORATIVE
	Independent Reading T67
	Literacy Activities T67
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T73
	Strategy and Intervention Activities T72
	Fluency T72
	ELL Targeted Support T72
	Conferring T73
INDEPENDENT/COLLABORATIVE
	Independent Reading T73
	Literacy Activities T73
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T79
	Strategy, Intervention, and On-Level/
Advanced Activities T78
	ELL Targeted Support T78
	Conferring T79
INDEPENDENT/COLLABORATIVE
	Independent Reading T79
	Literacy Activities T79
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T79 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T360–T361
»	How-To Books: Graphics: Genre Immersion
»	Share Back
INDEPENDENT WRITING
	How-To Book T360–T361
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T364–T365
»	Generate Ideas
»	Share Back
INDEPENDENT WRITING
	How-To Book T364–T365
	Conferences T350
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T368
»	Plan Your How-To Book
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T368–T369 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T350

	 WRITING BRIDGE	
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	Spelling: Review and More Practice: Homographs T362
	Language and Conventions: Teach Prepositions and Prepositional 
Phrases T363

	 WRITING BRIDGE	
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	Spelling: Spiral Review: Words with the Syllable Pattern VCCV T366
	Language and Conventions: Practice 
Prepositions and Prepositional 
Phrases T367

	 WRITING BRIDGE	
	Spelling: Homographs T370
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read informational text and learn facts about a topic.
	I can use language to make connections between reading and writing informational text.
	I can use elements of informational text to write a procedural text.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com
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Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T84–T85
»	Phonics: Decode Words with Double Consonants
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T86–T87
	Listening Comprehension: Read Aloud: “Volcanoes” and “Shifting Plates” T88–T89
	Informational Text T90–T91
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T98–T99
»	Phonics: Decode and Write Words with Double Consonants
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T99
»	High-Frequency Words
SHARED READ
	Introduce the Text T100–T121
»	Preview Vocabulary
»	Read: How Water Shapes the Earth
»	How Earthquakes Shape the Earth
	Respond and Analyze T122–T123
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T123
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Antonyms 
T92–T93
	Handwriting: Letters T and F T92–T93
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T97
	Strategy, Intervention, and On-Level/
Advanced Activities T96
	ELL Targeted Support T96
	Conferring T97
INDEPENDENT/COLLABORATIVE
	Independent Reading T97
	Literacy Activities T97
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T97 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T124
	Guided Reading/Leveled Readers T127
	Strategy and Intervention Activities T124, T126
	Fluency T124, T126
	ELL Targeted Support T124, T126
	Conferring T127
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T125
	Independent Reading T127
	Literacy Activities T127

	
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T376–T377
»	How to Write a Command
»	Share Back
INDEPENDENT WRITING
	How-To Book T376–T377
	Conferences T374
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T380–T381
»	Explore Writing Precise Instructions
»	Share Back
INDEPENDENT WRITING
	How-To Book T380–T381
	Conferences T374

	
	 WRITING BRIDGE	
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	Spelling: Words with Double 
Consonants T378
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	Language and Conventions: Spiral Review: Prepositions and Prepositional Phrases T379
	 WRITING BRIDGE	
	Spelling: Teach Words with Double Consonants T382
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T128–T129
»	Phonics: Review Words with Double Consonants
»	High-Frequency Words
CLOSE READ
	Compare and Contrast Texts T130–T131
	Close Read: How Water Shapes the Earth
»	How Earthquakes Shape the Earth
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T131
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T136–T137
»	Read Decodable Text: The Changing River
CLOSE READ
	Create New Understandings T138–T139
	Close Read: How Water Shapes the Earth
»	How Earthquakes Shape the Earth
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T139
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T142–T143
»	Revisit Decodable Text: The Changing River
»	Fluency
COMPARE TEXTS
	Reflect and Share T144–T145
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T145
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Cause and Effect T132–T133
	Handwriting: Letters G and S T132–T133
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T135
	Strategy and Intervention Activities T134
	Fluency T134
	ELL Targeted Support T134
	Conferring T135
INDEPENDENT/COLLABORATIVE
	Independent Reading T135
	Literacy Activities T135
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T141
	Strategy and Intervention Activities T140
	Fluency T140
	ELL Targeted Support T140
	Conferring T141
INDEPENDENT/COLLABORATIVE
	Independent Reading T141
	Literacy Activities T141
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T147
	Strategy, Intervention, and On-Level/
Advanced Activities T146
	ELL Targeted Support T146
	Conferring T147
INDEPENDENT/COLLABORATIVE
	Independent Reading T147
	Literacy Activities T147
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T147 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T384–T385
»	Apply Writing Precise Instructions
»	Share Back
INDEPENDENT WRITING
	How-To Book T384–T385
	Conferences T374
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T388–T389
»	Explore Graphics
»	Share Back
INDEPENDENT WRITING
	How-To Book T388–T389
	Conferences T374
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T392
»	Apply Graphics
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T392–T393 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	Conferences T374
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	 WRITING BRIDGE	
	Spelling: Words with Double Consonants
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read a reader’s theater and understand elements of drama.
	I can use language to make connections between reading and writing informational text.
	I can use elements of informational text to write a procedural text.
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png] SOCIAL-EMOTIONAL LEARNING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png]	Assessment Options 
for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T152–T153
»	Phonics: Vowel Sound Spelled aw, au, augh, al
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T154–T155
	Listening Comprehension: Read Aloud: “Preparing for the Storm” T156–T157
	Drama T158–T159
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 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T166–T167
»	Phonics: Decode and Write Words with aw, au, augh, al
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T167
»	High-Frequency Words
SHARED READ
	Introduce the Text T168–T185
»	Preview Vocabulary
»	Read: Where Do They Go in Rain or Snow?
	Respond and Analyze T186–T187
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T187
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Context Clues
T160–T161
	Handwriting: Letters L and P T160–T161
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T165
	Strategy, Intervention, and On-Level/
Advanced Activities T164
	ELL Targeted Support T164
	Conferring T165
INDEPENDENT/COLLABORATIVE
	Independent Reading T165
	Literacy Activities T165
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T165 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T188
	Guided Reading/Leveled Readers T191
	Strategy and Intervention Activities T188, T190
	Fluency T188, T190
	ELL Targeted Support T188, T190
	Conferring T191
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T189
	Independent Reading T191
	Literacy Activities T191

	
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T400–T401
»	Organize with Structure
»	Share Back
INDEPENDENT WRITING
	How-To Book T400–T401
	Conferences T398
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T404–T405
»	Explore Writing in Steps
»	Share Back
INDEPENDENT WRITING
	How-To Book T404–T405
	Conferences T398

	
	 WRITING BRIDGE	
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	Spelling: Words with aw, au, augh, 
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T192–T193
»	Phonics: Review Words with Vowel Sound Spelled aw, au, augh, al
»	High-Frequency Words
CLOSE READ
	Identify Elements of Drama T194–T195
	Close Read: Where Do They Go in Rain or Snow?
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T195
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T200–T201
»	Read Decodable Text: A Small Tree in a Big Wind
CLOSE READ
	Confirm or Adjust Predictions T202–T203
	Close Read: Where Do They Go in Rain or Snow?
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T203
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T206–T207
»	Revisit Decodable Text: A Small Tree in a Big Wind
»	Fluency
COMPARE TEXTS
	Reflect and Share T208–T209
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T209
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: 
Word Choice T196–T197
	Handwriting: Letters R and B T196–T197
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T199
	Strategy and Intervention Activities T198
	Fluency T198
	ELL Targeted Support T198
	Conferring T199
INDEPENDENT/COLLABORATIVE
	Independent Reading T199
	Literacy Activities T199
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T205
	Strategy and Intervention Activities T204
	Fluency T204
	ELL Targeted Support T204
	Conferring T205
INDEPENDENT/COLLABORATIVE
	Independent Reading T205
	Literacy Activities T205
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T211
	Strategy, Intervention, and On-Level/
Advanced Activities T210
	ELL Targeted Support T210
	Conferring T211
INDEPENDENT/COLLABORATIVE
	Independent Reading T211
	Literacy Activities T211
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T211 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]

	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T408–T409
»	Apply Writing in Steps
»	Share Back
INDEPENDENT WRITING
	How-To Book T408–T409
	Conferences T398
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T412–T413
»	Explore Introduction and Conclusion
»	Share Back
INDEPENDENT WRITING
	How-To Book T412–T413
	Conferences T398
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T416
»	Apply Introduction and Conclusion
»	Share Back
INDEPENDENT WRITING
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Writing.png]CLUB T416–T417 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
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	Spelling: Words with aw, au, augh, al T418
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can read poetry about Earth.
	I can use language to make connections between reading and writing informational text.
	I can use elements of informational text to write a procedural text.
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Materials
Turn the page for a list of materials that 
will support planning for the week.
)
	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T216–T217
»	Phonics: Decode Words with Syllable Pattern VCCCV
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T218–T219
	Listening Comprehension: Read Aloud: “Volcano Sleeps” T220–T221
	Poetry T222–T223
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T230–T231
»	Phonics: Decode and Write Words with Syllable Pattern VCCCV
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T231
»	High-Frequency Words
SHARED READ
	Introduce the Text T232–T253
»	Preview Vocabulary
»	Read: Volcano Wakes Up!
	Respond and Analyze T254–T255
»	My View
»	Develop Vocabulary
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»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Word Parts:
T224–T225
	Handwriting: Write Proper Nouns 
T224–T225
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T229
	Strategy, Intervention, and On-Level/
Advanced Activities T228
	ELL Targeted Support T228
	Conferring T229
INDEPENDENT/COLLABORATIVE
	Independent Reading T229
	Literacy Activities T229
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	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T256
	Guided Reading/Leveled Readers T259
	Strategy and Intervention Activities T256, T258
	Fluency T256, T258
	ELL Targeted Support T256, T258
	Conferring T259
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T257
	Independent Reading T259
	Literacy Activities T259

	
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T424–T425
»	Edit for Adverbs
»	Share Back
INDEPENDENT WRITING
	How-To Book T424–T425
	Conferences T422
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T428–T429
»	Explore Adding or Deleting Words
»	Share Back
INDEPENDENT WRITING
	How-To Book T428–T429
	Conferences T422

	
	 WRITING BRIDGE	
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	Spelling: Words with VCCCV Pattern 
T426
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T260–T261
»	Phonics: Review Words with Syllable Pattern VCCCV
»	High-Frequency Words
CLOSE READ
	Explain Patterns and Structures T262–T263
	Close Read: Volcano Wakes Up!
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T263
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T268–T269
»	Read Decodable Text: Lizard’s Move
CLOSE READ
	Make Connections T270–T271
	Close Read: Volcano Wakes Up!
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T271
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T274–T275
»	Revisit Decodable Text: Lizard’s Move
»	Fluency
COMPARE TEXTS
	Reflect and Share T276–T277
»	Write to Sources
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T277
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Patterns and Structures of Poetry 
T264–T265
	Handwriting: Practice Cursive Writing 
T264–T265
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T267
	Strategy and Intervention Activities T266
	Fluency T266
	ELL Targeted Support T266
	Conferring T267
INDEPENDENT/COLLABORATIVE
	Independent Reading T267
	Literacy Activities T267
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T273
	Strategy and Intervention Activities T272
	Fluency T272
	ELL Targeted Support T272
	Conferring T273
INDEPENDENT/COLLABORATIVE
	Independent Reading T273
	Literacy Activities T273
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T279
	Strategy, Intervention, and On-Level/
Advanced Activities T278
	ELL Targeted Support T278
	Conferring T279
INDEPENDENT/COLLABORATIVE
	Independent Reading T279
	Literacy Activities T279
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	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T432–T433
»	Apply Adding or Deleting Words
»	Share Back
INDEPENDENT WRITING
	How-To Book T432–T433
	Conferences T422
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T436–T437
»	Explore Rearranging Words
»	Share Back
INDEPENDENT WRITING
	How-To Book T436–T437
	Conferences T422
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T440
»	Apply Rearranging Words
»	Share Back
INDEPENDENT WRITING
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	 WRITING BRIDGE	
	Spelling: Words with VCCCV Pattern T442
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	Suggested Daily Times
READING WORKSHOP
FOUNDATIONAL SKILLS	20–30 min.
SHARED READING	40–50 min.
READING BRIDGE	5–10 min.
SMALL GROUP	25–30 min.
WRITING WORKSHOP
MINILESSON	10 min.
INDEPENDENT WRITING	30–40 min.
WRITING BRIDGE	5–10 min.
Learning Goals
	I can find the central idea in informational text.
	I can use language to make connections between reading and writing informational text.
	I can use elements of informational text to write a procedural text.
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for the Week
	Daily Formative Assessment Options
	Progress Check-Ups on SavvasRealize.com
	Cold Reads on SavvasRealize.com
	Writing Workshop Performance-Based Assessment on SavvasRealize.com
	Writing Workshop Assessment

	 LESSON 1 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T284–T285
»	Phonics: Decode Abbreviations
»	High-Frequency Words
GENRE & THEME
	Interact with Sources: Explore the Infographic: Weekly Question T286–T287
	Listening Comprehension: Read Aloud: “Ayers Rock” T288–T289
	Informational Text T290–T291
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) LESSON 2 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T298–T299
»	Phonics: Decode and Write Abbreviations
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T299
»	High-Frequency Words
SHARED READ
	Introduce the Text T300–T315
»	Preview Vocabulary
»	Read: Rocks!
	Respond and Analyze T316–T317
»	My View
»	Develop Vocabulary
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T317
»	Check for Understanding

	
	 READING BRIDGE	
	Academic Vocabulary: Oral Language
T292–T293
	Handwriting: Practice Cursive Writing 
T292–T293
	

	
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T297
	Strategy, Intervention, and On-Level/
Advanced Activities T296
	ELL Targeted Support T296
	Conferring T297
INDEPENDENT/COLLABORATIVE
	Independent Reading T297
	Literacy Activities T297
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Book.png] CLUB T297 [image: Mac:Users:santosh:Desktop:Abhinav_word template:link:SEL.png]
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Word Work Support T318
	Guided Reading/Leveled Readers T321
	Strategy and Intervention Activities T318, T320
	Fluency T318, T320
	ELL Targeted Support T318, T320
	Conferring T321
INDEPENDENT/COLLABORATIVE
	Word Work Activity and Decodable Reader T319
	Independent Reading T321
	Literacy Activities T321

	
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T448–T449
»	Edit for Pronouns
»	Share Back
INDEPENDENT WRITING
	How-To Book T448–T449
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T452–T453
»	Edit for Capitalization
»	Share Back
INDEPENDENT WRITING
	How-To Book T452–T453
	Conferences T446
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	Spelling: Teach Abbreviations T454
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	 LESSON 3 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T322–T323
»	Phonics: Review Abbreviations
»	High-Frequency Words
CLOSE READ
	Identify Main Idea T324–T325
	Close Read: Rocks!
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T325
	 LESSON 4 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T330–T331
»	Read Decodable Text: Welcome, Max
CLOSE READ
	Make Inferences T332–T333
	Close Read: Rocks!
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T333
	 LESSON 5 
 READING WORKSHOP	
FOUNDATIONAL SKILLS
	Word Work T336–T337
»	Revisit Decodable Text: Welcome, Max
»	Fluency
COMPARE TEXTS
	Reflect and Share T338–T339
»	Talk About It
[image: Mac:Users:santosh:Desktop:Abhinav_word template:link:Check.png] Quick Check T339
»	Weekly Question

	 READING BRIDGE	
	Read Like a Writer, Write for a Reader: Descriptive Details T326–T327
	Handwriting: Practice Cursive Writing 
T326–T327
	
	

	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T329
	Strategy and Intervention Activities T328
	Fluency T328
	ELL Targeted Support T328
	Conferring T329
INDEPENDENT/COLLABORATIVE
	Independent Reading T329
	Literacy Activities T329
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T335
	Strategy and Intervention Activities T334
	Fluency T334
	ELL Targeted Support T334
	Conferring T335
INDEPENDENT/COLLABORATIVE
	Independent Reading T335
	Literacy Activities T335
	 SMALL GROUP/INDEPENDENT	
TEACHER-LED OPTIONS
	Guided Reading/Leveled Readers T341
	Strategy, Intervention, and On-Level/
Advanced Activities T340
	ELL Targeted Support T340
	Conferring T341
INDEPENDENT/COLLABORATIVE
	Independent Reading T341
	Literacy Activities T341
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	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T456–T457
»	Prepare for Celebration
»	Share Back
INDEPENDENT WRITING
	How-To Book T456–T457
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T460–T461
»	Publish and Celebrate
»	Share Back
INDEPENDENT WRITING
	How-To Book T460–T461
	Conferences T446
	 WRITING WORKSHOP	
MINILESSON
	Procedural Text T464
»	Assessment
INDEPENDENT WRITING
	Assessment T464–T465
	Conferences T446

	 WRITING BRIDGE	
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	Spelling: Abbreviations T466
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 PROJECT FOCUS 	This week students will
	•	write a persuasive infomercial about Earth
	•	record infomercials with sound effects and visuals

	 LESSON 1	
T474–T475,
T476
T484–T485
RI.2.1, RI.2.10,
RF.2.3, L.2.2

	Foundational Skills
•	Phonics: Decode Words with Final Stable Syllables
•	Spelling
	Compare Across Texts
•	Answer the Essential Question

	Inquire
•	Introduce the Project 
•	Read “The History of Advertising”
•	Use Academic Words

	

	 LESSON 2	
T474–T475,
T476
T484–T485
RF.2.3, W.2.1, W.2.5, W.2.7, L.2.2

	Foundational Skills
•	Phonics: Decode and Spell Words with Final Stable Syllables
•	Spelling: Final Stable Syllables consonant-le, 
-tion, -sion

	Explore and Plan
•	Introduce Argumentative Writing
•	Read: “Player One”
	Conduct Research
•	Use Media to Research


	


	

		LESSON 3	
T480–T481,
T477
T490–T491
RF.2.3, W.2.1, L.2.2

	Foundational Skills
•	Phonics: Final Stable Syllables consonant-le, 
-tion, -sion
•	High-Frequency Words
•	Spelling

	Collaborate and 
Discuss
•	Analyze Student Model
	Refine Research
•	Cite Your Sources
•	Read “Turn It Off!”

	




	

		LESSON 4	
T482–T483,
T477
T492–T493
RF.2.3, W.2.1,
W.2.5, L.2.2

	Foundational Skills
•	Phonics: Review Final Stable Syllables consonant-le, -tion, -sion
•	Spelling

	Extend Research
•	Make a Video or Record Infomercial
	Collaborate and 
Discuss
•	Revise and Edit


	




	

	 LESSON 5	
T482–T483, 
T477
T494–T495
RF.2.3, W.2.1,
W.2.6, L.2.2

	Foundational Skills
•	Phonics: Spiral Review: Abbreviations
•	Spelling
	Celebrate and Reflect
•	Present Infomercials
•	Reflect on Your Project
	Reflect on the Unit
•	Reflect on your goals
•	Reflect on your reading
•	Reflect on your writing
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